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ЛАБОРАТОРНАЯ РАБОТА № 1 

 

ИЗУЧЕНИЕ ПРИЕМОВ РАБОТЫ В СИСТЕМЕ MATLAB 

 

ЦЕЛЬ РАБОТЫ: отработать навыки работы в системе научных иссле-

дований Matlab. 

Достижение поставленной цели связано с необходимостью решения 

следующих задач: 

– изучить интерфейс системы Matlab; 

– научиться работать в системе Matlab в режиме калькулятора; 

– изучить окно редактора/отладчика и возможности работы в нем; 

– научиться строить простейшие графики. 

 

2. ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

2.1. Рабочее окно. 

После запуска программы Matlab на дисплее компьютера появляется её 

рабочее окно, содержащее меню, панель инструментов с кнопками, окно ра-

бочей области Workspase, окно Command History и клиентскую часть окна со 

знаком приглашения  , которое принято называть командным окном Com-

mand Window системы Matlab.  

Строка меню (File, Edit, View и т.д.) во многом схожа с аналогичной 

строкой редактора Microsoft Word. Расположенный ниже ряд пиктограмм 

также выполняют те же операции, что и в редакторе Word (за исключением 

1-ой пиктограммы, запускающей пакет SimuLink). 

Окно Command History содержит по порядку введённые ранее коман-

ды. Рабочая область Workspase – это область памяти Matlab, в которой раз-

мещены переменные системы. 

2.2. Работа в системе Matlab в режиме калькулятора 

В клиентской части командного окна Command Window Matlab после 

знака приглашения можно вводить различные числа, имена переменных и 

знаки операций, что в совокупности составляет некоторые выражения.  

Основные арифметические операции выполняются с помощью тради-

ционных знаков: "+", "-", "*", "/" (деление слева направо), "\" (деление справа 

налево), "^" (возведение в степень). Интерес представляют операции поэле-

ментного умножения и деления: ".*", "./", ".\".   Знак "=" соответствует опера-

ции присваивания.   

Переменные в системе Matlab — это имеющие имена объекты, способ-

ные хранить некоторые, обычно разные по значению, данные. В зависимости 

от этих данных переменные могут быть числовыми или символьными, век-

торными или матричными и т.д.  Типы переменных заранее не декларируют-

ся. Они определяются выражением, значение которого присваивается пере-

менной.  

Имя переменной (ее идентификатор) может содержать не более 31 

символа. Имя любой переменной не должно совпадать с именами других пе-

ременных, функций и процедур системы, т.е. оно должно быть уникальным. 
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Имя должно начинаться с буквы, может содержать цифры и символ подчер-

кивания _. Недопустимо включать в имена переменных пробелы и специаль-

ные знаки, например +, -, /. 

Нажатие клавиши Enter заставляет систему Matlab вычислить выраже-

ние или, если оно не вычисляется, повторить его. Результат присваивается 

параметру "ans", если выражение не было присвоено какой –либо перемен-

ной (пример 1).  

Пример 1.  

>> 2+3 

ans= 

         5 

или 

>> а=2+3 

a= 

5 

 

Чтобы информация не дублировалась нужно завершить строку симво-

лом ";",   который означает  конец  строки (пример 2). 

 

Пример 2. 

>> a=2 

a = 

     2 

>> b=4; 

>> с=a+b 

с = 

      6 

Таким образом, в командном окне Matlab пользователь может сразу 

писать команды, образующие отдельные вычисления или целую программу.  

Командой сlс можно стереть видимое содержимое командного окна, 

однако это не затронет содержимого рабочего пространства.  

По мере увеличения размера рабочего пространства эффективность ра-

боты будет снижаться. Поэтому, когда исчезает необходимость в хранении 

ряда переменных в текущем сеансе работы, их можно стереть из памяти ком-

пьютера командой  сlеаr имя1 имя2, удаляющей из рабочего пространства 

переменные с именами имя1 и имя1. Чтобы удалить сразу все переменные, 

нужно использовать команду сlеаr. 

В системе Matlab определено несколько базовых типов данных, каж-

дый из которых является тем или иным видом массива. Это означает, что все 

данные системы Matlab являются массивами. 

Ниже приведены способы ввода векторов (одномерный массив) и мат-

риц (двумерный массив). 
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 Пример 3. 

>> а=[1 3 4] 

a= 

    1 3 4 

Пример 4. 

>> а=-0.01:0.3:0.8 

a= 

-0.01 0.29 0.59 

 

Пример 5. 

>> а=-1.1:1.9 

a= 

-1.1 -0.1 0.9 1.9 

 

Пример 6. 

>> а=[3 5 2;4 5 6;7 8 9] 

a= 

3 5 2 

4 5 6 

    7 8 9 

 

Формат представления чисел на экране дисплея по желанию пользова-

теля можно регулировать с помощью команды format. Эта команда опреде-

ляет лишь форму вывода результатов и не влияет на точность вычислений, а 

также на формат представления и хранения чисел (в системе Matlab вычис-

ления всегда выполняются с двойной точностью). 

По умолчанию при загрузке системы устанавливается формат short. Он 

отображает только 5 значащих десятичных цифр числа. Другие форматы поз-

воляют отобразить большее число десятичных цифр или используют экспо-

ненциальное представление чисел.  

 

 

  
 

Формат числа можно также задать в меню File в разделе Preferences с 

помощью функции Numeric Format. Наиболее часто используемыми из 12-ти 

возможных являются форматы Short и Long – краткий и длинный форматы 

чисел.  
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Пример 7. 

Вычислим значение функции log(4) : 

>> log(4) 

ans = 

    1.3863  

 

Пример 8. 

>> format long 

>> log(4)   

ans = 

1.38629436111989 

 

2.3. Визуализация результатов вычислений. Графика 

Графические возможности системы Matlab являются мощными и разно-

образными. В первую очередь целесообразно изучить наиболее простые в 

использовании возможности. Их часто называют высокоуровневой графи-

кой. Это название отражает тот факт, что пользователю нет никакой необхо-

димости вникать во все тонкие и глубоко спрятанные детали работы с гра-

фикой.  

Matlab показывает графические объекты в специальных графических 

окнах, имеющих в заголовке слово Figure (фигура, изображение). 

Рассмотрим двумерную графику. Вот несколько действий, которые 

позволят добиться необходимой визуализации:  

 

ДЕЙСТВИЕ ПРИМЕРЫ 

Построить график функции одной 

вещественной переменной: 

1) вычислить массив у значений 

функции для заданного набора аргу-

ментов (или задать массивы аргумен-

та и значений функции)  

2) вызов функции plot.  

>> x=0:0.01:2; 

>> y=sin(x); 

>> plot(x,y) ; 

>> x=[0.5 2 3 ]; 

>> y=[1 5 2]; 

>> plot(x,y); 

Построить два и более графиков в 

одной системе координат:  

команда hold on или функция 

plot(x1,y1,x2,y2,…,xn,yn). Последняя 

строит графики разным цветом 

>> x=0:0.01:2;  

>> y1=sin(x); y2=cos(x); 

>> plot(x,y1)  

>> hold on 

>> plot(x,y2); 

>>plot(x,y1,x,y2); 

Построить k графиков в разных 

графических окнах: перед функцией 

plot (начиная со второй) запись ко-

манды figure. 

>> plot(x1,y1); <…> 

>> figure; plot(x2,y2); <…> 

>> figure; plot(x3,y3); <…> 

>> figure; plot(xk,yk); 

Построить в одном графическом 

окне, но на отдельных графических 

полях, k графиков: перед функцией 

<…> 

>> subplot(2,1,1); 

>> plot(x1,y1); 
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рlot используется функция 

subplot(m,n,p). Здесь  m указывает на 

сколько частей графическое окно де-

лится по вертикали, n – по горизонта-

ли, а p является номером подокна, в 

котором будет строиться график.  

>> subplot(2,1,2); 

>> plot(x2,y2); 

<…> 

 

Построить график в полярных ко-

ординатах: функция polar. 

>> phi=0:0.01:2*pi; r=sin(3*phi); 

>> polar(phi,r) 

 

С помощью команды plot можно также регулировать толщину и вид ли-

ний и т.п. (с остальными вариантами синтаксиса команды plot можно озна-

комиться с помощью справки Matlab – меню help). 

Рассмотрим некоторые команды для оформления графиков построенных 

в окне Figure. 

Используя команду grid on можно нанести измерительную сетку на всю 

область построения графика. 

Для проставления различных надписей на полученном рисунке приме-

няют функции: 

title('<текст>') – заголовок графика; 

xlabel('<текст>') – текст вдоль горизонтальной оси; 

ylabel('<текст>') – текст вдоль вертикальной оси; 

text (x,y,'<текст>') – надпись в произвольном месте рисунка, где x,y – 

координаты точки, с которой начинается надпись. 

График можно сохранить в формате Matlab с расширением fig или в 

другом графическом формате. 

Нужно отметить, что окно Figure имеет свою собственную строку ме-

ню и панель инструментов для оформления графиков. Однако при написании 

программ удобно использовать команды для работы с графическими окнами. 

 

2.4. Редактор/отладчик 

Работа в режиме калькулятора в системе Matlab, несмотря на довольно 

значительные возможности, имеет существенные недостатки. При решении 

серьезных задач возникает необходимость сохранения используемых после-

довательностей вычислений, а также их дальнейшей модификации. Иными 

словами, существует необходимость программирования решения задач.  

Это может показаться отходом от важной цели, которая преследуется 

разработчиками большинства математических систем, — выполнения мате-

матических вычислений без использования традиционного программирова-

ния. Однако это не так. Множество математических задач решается в системе 

MATLAB без программирования. С использованием языков высокого уровня 

для их решения потребовалось бы написать и оттестировать сотни программ.  

Программирование в системе Matlab является эффективным средством 

ее расширения и адаптации к решению специфических проблем. Оно реали-

зуется с помощью языка программирования системы. Большинство объектов 

этого языка, в частности все команды, операторы и функции, одновременно 
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являются объектами входного языка общения с системой в командном режи-

ме работы.  

Так в чем же отличие входного языка от языка программирования? В 

основном – в способе фиксации создаваемых ими кодов. Сессии в командном 

режиме работы не сохраняются в памяти компьютера (ведение дневника не в 

счет). Хранятся только определения созданных в ходе их выполнения пере-

менных и функций. А вот программы на языке программирования Matlab со-

храняются в виде текстовых М-файлов. При этом могут сохраняться как це-

лые программы в виде файлов-сценариев (Script-файлы, М-сценарии или 

управляющие программы)), так и отдельные программные модули — функ-

ции (файл-функции, М-функции). Кроме того, важно, что программа может 

менять структуру алгоритмов вычислений в зависимости от входных данных 

и данных, создаваемых в ходе вычислений.  

Создание программы в системе Matlab осуществляется при помощи 

встроенного редактора/отладчика. Окно редактора появляется на экране, если 

вызвана команда File>New>M-file из рабочего окна. 

 

Пример 8. 

Найдем корни системы линейных алгебраических уравнений: 

432

1552

14432

321

321

321







xxx

xxx

xxx

 

Напишем файл-сценарий. При вычислении корней применим операцию 

обратного деления. 

 

 
Рис. 1 

 

Запуск программы осуществляется из редактора/отладчика выбором 

соответствующего пункта меню (Debug>Run) или нажатием F5 или с помо-

щью соответствующей кнопки на панели инструментов (рис.1). 

Результат вычисления можно увидеть в командном окне: 

>> x = 

            3 

           -4 

            5  

В командном окне также выдаются сообщения об ошибках в М –файле. 

Run 
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3. ОБЪЕКТ ИССЛЕДОВАНИЯ 

 

Объектом исследования является система MATLAB. 

 

4. ЗАДАНИЕ НА ИССЛЕДОВАНИЕ 

1) Познакомится с интерфейсом системы MATLAB. 

2) Во всех заданиях требуется занести в некоторую переменную значе-

ния выражений при заданных 31075.1 x  и 1.3y , отобразить результат в 

различных форматах. 
 

вариант выражение вариант выражение 

1. 

 

8. 

 
2. 

 

9. 

 
вариант выражение вариант выражение 

3. 

 

10. 

 
4. 

 

11. 

 
5. 

 

12. 

 
6. 

 

13. 

 

7. 

 

14. 

 
 

Примечание. 

sin(z) – синус числа z; cos(z) – косинус числа z; tan(z) – тангенс числа z; asin(z) – 

арксинус (в радианах, в диапазоне от 2/  до 2/ ); acos(z) – арккосинус (в радианах, в 

диапазоне от 0  до  ); atan(z) – арктангенс (в радианах, в диапазоне от 2/  до 2/ ); 

sinh(z) – гиперболический синус числа z; cosh(z) – гиперболический косинус числа z; 

tanh(z) – гиперболический тангенс числа z; exp(z) – экспонента числа z; log(z) – натураль-

ный логарифм числа z; log10(z) – десятичный логарифм числа z; sqrt(z) – квадратный ко-

рень из числа z; abs(z) – модуль числа z. 
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3) Изучить графические возможности системы MATLAB. Используя 

редактор/отладчик построить графики функций: 

а) )(1 xfy   

б) )(11 xfy   и )(22 xfy   в одном графическом окне и в одной системе 

координат; 

в) )(11 xfy   и )(22 xfy   в разных графических окнах; 

г) )(11 xfy   и )(22 xfy   в одном графическом окне, но на отдельных 

графических полях. 

 Все графики должны содержать заголовки, обозначения осей, мас-

штабную сетку, обозначения кривых. Для этого использовать соответствую-

щие функции, а не команды настройки окна Figure.  

Чтобы пометить график в отчет нужно в главном меню окна Figure вы-

брать Edit>Copy Figure, открыть файл отчета и выполнить команду Ctrl+V.  

 

Далее приведены функции )(xfy   для вариантов задания: 

 

вариант функции вариант функции 

1. xey 1 , xy  22 . 8. 41  xy , )sin(2 xy  . 

2. xy lg1  , xy 22  . 9. xxy  2
1 , 3

2 xy  . 

3. )cos(1 xxy  , 4
2 xy  . 10. xey 5.0

1  , 3
2 xy  . 

4. xxy 22
1  , xy 22  . 11. )ln(51 xy  , )(2 xtgy  . 

5. xxy  )ln(1 , )cos(2 xy  . 12. 31  xey , xy  22 . 

6. 5
1

 xey , xy 2 . 13. 342 23
1  xxy , )2sin(2 xy  . 

7. )ln(1 xy  , xy 22  . 14. 2
1 4  xy , xy 2 . 

 

 

5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

 

1. Запустить среду MATLAB (ярлык MATLAB на рабочем столе). 

2. Изучить работу в систем MATLAB в режиме калькулятора, выпол-

нив описанные в разделе теоретические сведения примеры. 

3. Вычислить значение арифметического выражения (в режиме кальку-

лятора). Отобразить результат в различных форматах. 

4. Вызвать редактор/отладчик и используя графические возможности 

системы MATLAB построить графики указанных в задании функций.  
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6. ТРЕБОВАНИЯ К ОФОРМЛЕНИЮ ОТЧЕТА 

 

Отчет должен содержать: 

1. Название и номер работы, цель работы. 

2. Арифметическое выражение и результат его вычисления в различ-

ных форматах. 

3. Тексты Script-файлов и графики функций с заголовками, обозначе-

ниями осей, масштабной сеткой, обозначениями кривых. 

 

7. КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

1. Что представляет собой рабочее окно системы MATLAB? 

2. Зачем предназначено командное окно Command Window? 

3. Зачем используется символ «;» при написании переменных, выраже-

ний и т.д.? 

4. Как задать вектор? 

5. Опишите графические возможности системы MATLAB для визуали-

зации двумерных графиков. 

6. Для чего нужен редактор/отладчик? 

7. Какое расширение имеют файлы системы MATLAB? 
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ЛАБОРАТОРНАЯ РАБОТА № 2 

 

СОЗДАНИЕ М-ФАЙЛОВ И ИХ ИСПОЛЬЗОВАНИЕ 

ДЛЯ РЕШЕНИЯ ДИФФЕРЕНЦИАЛЬНЫХ УРАВНЕНИЙ 

 

1. ЦЕЛИ И ЗАДАЧИ ИССЛЕДОВАНИЯ: 

– познакомиться с возможностями программирования в системе 

MATLAB и научиться создавать простейшие программы. Достижение по-

ставленной цели связано с необходимостью решения следующих задач: 

– изучить редактор М-файлов MATLAB; 

– научиться использовать М-файлы для решения дифференциальных 

уравнений. 

 

2. ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

2.1. Программирование в системе MATLAB. Создание простейших 

программ. 

Создание программы в системе MATLAB осуществляется при помощи 

встроенного редактора/отладчика. Окно редактора появляется на экране, если 

вызвана команда File>New>M-file из рабочего окна или нажата кнопка «бе-

лый лист» на панели инструментов рабочего окна. 

В языке MATLAB имеются программы двух типов: так называемые 

Script-файлы (М-сценарии) (файл-сценарии или управляющие программы) и 

файл-функции (М-функции). Все программы должны иметь расширение 

имен файлов *.m, т.е. их нельзя различить по типу файла.  

Опишем их по следующему плану: 1) предназначение; 2) используемые 

аргументы; 3) оперирование с данными; 4) структура; 5) запуск. 

М-сценарий: 

1. Предназначен для автоматизации последовательности шагов, кото-

рые нужно выполнять много раз. 

2. Не использует входных и выходных аргументов. 

3. Оперирует с данными из рабочей области. 

4. Структура М-сценария в отличие от М-функции не включает строку 

определения функции. 

5. Запуск из Редактора/Отладчика выбором соответствующего пункта 

меню (Debug>Run) или нажатием F5. 

М-функция: 

1. Предназначена для расширения возможностей языка MATLAB (биб-

лиотеки функций, пакеты прикладных программ). 

2. Использует входные и выходные аргументы. 

3. По умолчанию, внутренние переменные являются локальными по 

отношению к функции. 

4. Структура:  

1) Строка определения функции задаёт имя, количество и порядок 

следования входных и выходных аргументов: 

function <ПКВ> =<имя функции>(<ПВВ>), 
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ПКВ – перечень конечных величин, ПВВ – перечень входных величин. 

Например: function y = funa(x,a), где function - ключевое слово, опре-

деляющее М-функцию; y - выходной аргумент; funa - имя функции; x, а - 

входные аргументы. 

Если функция имеет более одного выходного аргумента, список вы-

ходных аргументов помещается в квадратные скобки: function [x, y, z] = 

funb(t, p, r). 

! Имя файла и имя функции должны совпадать. 

Если имя файла и имя функции в строке определения функции разные, 

то при запуске используется имя файла, а внутреннее имя игнорируется. На 

имена М-функций налагаются те же ограничения, что и на имена переменных 

- их длина не должна превышать 31 символа; они должны начинаться с бук-

вы; остальные символы могут быть любой комбинацией букв, цифр и под-

черкиваний. 

2) Комментарий выводится на экран после знака % в любом месте. 

Первая строка комментария отражается в Окне команд, когда пользователь 

запускает команду help <имя_функции>. 

3) Тело функции - это программный код, который реализует вычисле-

ния и присваивает значения выходным аргументам. 

5. Запуск из Окна команд с описанием входных аргументов. 

 

Пример 1. Дана функция myfun(a,b), считающая среднеарифметиче-

ское двух чисел (рис. 1).  

 

 
рис. 1 

 

Её запуск из командного окна Command Window: 

>> m = 7.5; 

>>n = 3.342;  

>>c = myfun(m, n)  

c = 5.421  

>>c = myfun(7.5, 3.342)  

c =5.421  

 

Функция должна находится в текущей директории. Имена входных пе-

ременных могут, но не обязаны совпадать с именами, указанными в строке 

определения функции.  
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При оперировании с М-файлами можно использовать следующие ко-

манды:  

- вывести на экран имена файлов текущего каталога: what;  

- вывести на экран текст M-файла fact.m: type fact. 

 

Пример 2. Создать программу, позволяющую строить график функции 

)(xy  , заданных параметрическими формулами: 

)sin(4 05.0 tex t , 

)2sin(2.0 1.0 tey t . 

Выберем диапазон изменения параметра t от 0 до 50 с шагом 0.1. 

Сначала напишем М-функцию для заданной функции (рис. 2). 

 

 
рис. 2 

 

В программе используется арифметическая операция – поэлементное 

умножение массивов (.*). Отличие указанной операции от скалярного и век-

торного умножения векторов показано в примерах 1-3. 

Операция «’» – транспонирование вектора.  

Пример 3. Пример 4. Пример 5. 

>>а = [1 2 3]; 

>>b = [2 3 6]; 

>>c=a.*b 

c= 

    2 6 18 

>>а = [1 2 3]; 

>>b = [2 3 6]; 

>>c=a*b’ 

c= 

    26 

>>а = [1 2 3]; 

>>b = [2 3 6]; 

>>c=a’*b 

c= 

    2   3   6 

    4   6   12 

    6   9   18 

 

Затем, набирая совокупность операторов, напишем М-сценарий (рис. 3) 

и получим график функции. 

Запуск на выполнение М-сценария осуществляется с помощью кнопки 

Run или нажатием F5. 

А’ 
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рис. 3 

 

2.2. Решение дифференциальных уравнений 

Система MATLAB имеет несколько функций, реализующих численные 

методы Рунге-Кутты третьего, четвертого, пятого и шестого порядков с ав-

томатическим выбором шага, для решения дифференциальных уравнений и 

систем высокого порядка в форме Коши с табличным и графическим пред-

ставлением результатов. 

Рассмотрим функцию, реализующую метод Рунге-Кутты 4-го порядка: 

[t, y]=ode45 (‘<имя функции>’, tspan, y0), 

где <имя функции> – имя М-функции, в которой вычисляется вектор-

функция ),( tyf , т.е. правые части системы дифференциальных уравнений; 

t – массив значений аргумента, соответствующих шагам интегрирования; 

y – матрица проинтегрированных значений фазовых переменных, в которой 

каждый столбец соответствует одной из переменных состояния, а строка со-

держит значения переменных состояния, соответствующих определенному 

шагу интегрирования; 

tspan – вектор-строка [t0 tfinal], содержащая два значения: t0 – начальное 

значение аргумента t; tfinal – конечное значение аргумента t; 

y0 – вектор начальных значений переменных состояния. 

Технология решения дифференциальных уравнений такова: 

1. Создание новой функции, представляющей собой М-функцию вы-

числения правых частей системы дифференциальных уравнений (уравнение 

должно быть в форме Коши). 

2. Ввод функции ode45 (в командном окне Command Window или в ре-

дакторе/отладчике, оформив как М-сценарий). Функция ode45 требует, что-

бы вектор производных был обязательно столбцом. 

Пример 6 

Дано уравнение  

)20)((4.0)(  tTtT ,  90)0( T ,                                (1) 

которое описывает закон охлаждения тела разогретого до температуры Т=900 

и помещенного в среду температуры Т=200. Требуется построить зависи-

мость  Т(t) на интервале времени  ]15;0[t . 

Run 
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М-функция правой части уравнения (1) имеет вид, представленный на 

рис. 4. 

 

 
рис. 4 

 

На рис. 5 приведен М-сценарий построения графика функции Т(t). 

На рис. 5: 

t- массив значений аргумента – в нашем случае время интегрирования; 

Т- вектор значений температуры. 

 

 
рис. 5 

Результат выполнения программы progr_temp.m представлении на рис. 6. 

 

 
рис. 6 

 

Пример 7 
Дано уравнение Дуффинга, которое демонстрирует возникновение сто-

хастических колебаний для ряда нелинейных задач, в частности хаотическую 
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динамику цепи с нелинейной индуктивностью или продольный изгиб упру-

гой балки. Уравнение имеет вид 

)cos()()()( 3 tBtxtkxtx  .    (2) 

Динамика определяется параметрами k ,B, а также начальными услови-

ями. Варьируя параметры, можно наблюдать различные режимы движения: 

от периодических до хаотических. 

Пусть 5.2)0(,0)0(  xx , 3.0k , 2B , ]50;0[t . 

М-функция правых частей уравнения (2) в форме Коши имеет вид: 

function dx=duffing(t,x); 

dx(1)=x(2); 

dx(2)=2*cos(t)-0.3*x(1)-x(1).^3; 

dx=dx';               %  вектор dx должен быть вектором столбцом  

 

Далее приведен текст М-сценария, результат выполнения которого 

приведен на рис. 7: 

[t,X]=ode45('duffing',[0 50],[2.5 0]); 

subplot(3,1,1); 

plot(t,X(:,1));grid on           %  строим график x(t)  

title('X''''+3X+X^3=2cos(t)','Fontsize',14); 

xlabel('t','Fontsize',14); 

ylabel('X','Fontsize',14); 

subplot(3,1,2); 

plot(t,X(:,2));grid on              %  строим график x(t) 
xlabel('t','Fontsize',14); 

ylabel('X''','Fontsize',14); 

subplot(3,1,3); 

plot(X(:,1),X(:,2));grid on      %  строим график x(x) – фазовый портрет  

axis([-5 5 -5 5]);        % устанавливаем жесткие границы поля графика 

xlabel('X','Fontsize',14); 

ylabel('X''','Fontsize',14); 

 

Здесь t- массив значений аргумента – в нашем случае время интегрирования; 

X - матрица проинтегрированных значений фазовых переменных 1x  и 2x . 
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рис. 7 

 

3. ОБЪЕКТ ИССЛЕДОВАНИЯ 

 

Объектом исследования является система MATLAB. 

 

4. ЗАДАНИЕ НА ИССЛЕДОВАНИЕ 

 

1. Познакомится с интерфейсом редактора MATLAB, позволяющего 

создавать М-файлы. 

2.Создать М-функцию для функции )25.0sin(3)(  xxf . Найти значе-

ния функции на промежутке ];0[   с шагом 10/  и построить ее график на 

промежутке ]3;3[   с шагом 100/ . 

3. С помощью использования М-файлов найти y(t) и y (t),yt), y (y) диф-

ференциальных уравнений первого и второго порядка соответственно. Для 

уравнения второго порядка построить в одном графическом окне на одном 

графическом поле графики y (t),y(t), а на другом y (y). 
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Уравнения выбираются в соответствии с таблицей 1. 

Табл. 1. 

 

Вариант Уравнение первого порядка Уравнение второго порядка 

1 1 1 

2 2 2 

3 3 3 

4 4 4 

5 5 5 

6 6 6 

7 7 7 

8 8 8 

9 9 9 

10 10 10 

11 11 11 

 

Далее приведены дифференциальные уравнения для вариантов зада-

ния. Начальные условия и время моделирования выбрать самостоятельно. 

 

Уравнения первого порядка: 

Вариант 1. 
42

52
`






yt

ty
y , )(oy …, nttt ...0  

Вариант 2. 
2

2

)1(

)2(2
`






yt

y
y , )(oy …, nttt ...0  

Вариант 3. 1`cossin  tyty , )(oy …, nttt ...0  

Вариант 4. 02`)1( 322  tyyyt , )(oy …, nttt ...0  

Вариант 5. tety 1` , )(oy …, nttt ...0  

Вариант 6. 0ln` 2  tyyty , )(oy …, nttt ...0  

Вариант 7. 0cos` 2  tytgtyy , )(oy …, nttt ...0  

Вариант 8. 
t

y

t

y
y

2cos

22
`  , )(oy …, nttt ...0  

Вариант 9. 04` 2  ytyty , )(oy …, nttt ...0  

Вариант 10. tgy
y

t
y 

cos
` , )(oy …, nttt ...0  

Вариант 11. )sin1(cos`cos 2 ttytyy  , )(oy …, nttt ...0  

Уравнения второго порядка: 

Вариант 1. tty sin``  , )`(oy …, )(oy …, nttt ...0  

Вариант 2. ``` yty  , )`(oy …, )(oy …, nttt ...0  

Вариант 3. 1`)(```2 2  yyty , )`(oy …, )(oy …, nttt ...0  

Вариант 4. ``2`)(1 2 yyy  , )`(oy …, )(oy …, nttt ...0  
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Вариант 5. 32 )()(`` yyyy  , )`(oy …, )(oy …, nttt ...0  

Вариант 6. 22 4`)(3``2 yyyy  , )`(oy …, )(oy …, nttt ...0  

Вариант 7. ``)(`` 22 yyyyy  , )`(oy …, )(oy …, nttt ...0  

Вариант 8. 2`)(`ln`` yyyyyy  , )`(oy …, )(oy …, nttt ...0  

Вариант 9. 34 )(`` ytyyt  , )`(oy …, )(oy …, nttt ...0  

Вариант 10. )1(`)(2 2  yyy , )`(oy …, )(oy …, nttt ...0  

Вариант 11. yyyttyy  3)(`` 2 , )`(oy …, )(oy …, nttt ...0  

 

5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

 

1. Запустить среду MATLAB (ярлык MATLAB на рабочем столе). По-

явится окно среды MATLAB.  

2. Запустить редактор М-файлов. Создать М-функцию для функции 

)25.0sin(3)(  xxf . 

3. Открыть командное окно Command Window и найти значения функ-

ции на промежутке ];0[   с шагом 10/ . Построить график функции на про-

межутке ]3;3[   с шагом 100/ . 

Можно написать М-сценарий поиска значения и построения графика 

функции. 

4. Запустить редактор/отладчик М-файлов. Создать М-функцию правой 

части уравнения первого порядка и создать М-сценарий для поиска решения 

y(t) и построения его графика.  

5. Создать М-функцию правых частей уравнения второго порядка и со-

здать М-сценарий для поиска y (t), y(t), y (y) и построения соответствующих 

графиков. 

 

6. ТРЕБОВАНИЯ К ОФОРМЛЕНИЮ ОТЧЕТА 

 

Отчет должен содержать: 

1. Название и номер работы, цель работы. 

2. Текст М-функции для функции )25.0sin(3)(  xxf . Значения функ-

ции на промежутке ];0[   с шагом 10/  и график функции на промежутке 

]3;3[   с шагом 100/ . 

3. Текст М-функции правой части уравнения первого порядка и М-

сценария. График найденного решения y(t). 

4. Текст М-функции правых частей уравнения второго порядка и М-

сценария. Графики найденных функций y (t),yt), y (y). 
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7. КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

1. Чем отличается М-сценарий от М-функции? 

2. С какой строки начинается М-функция? 

3. Опишите функцию для решения дифференциальных уравнений? 

 

 



 22 

 

ЛАБОРАТОРНАЯ РАБОТА № 3 

 

РЕШЕНИЕ ДИФФЕРЕНЦИАЛЬНЫХ УРАВНЕНИЙ 

В ПАКЕТЕ SIMULINK 

 

1. ЦЕЛИ И ЗАДАЧИ ИССЛЕДОВАНИЯ: 

познакомиться с пакетом имитационного моделирования SimuLink и изучить 

возможности решения с его помощью дифференциальных уравнений. До-

стижение поставленной цели связано с необходимостью решения следующих 

задач: 

– изучить интерфейс и библиотеку блоков пакета SimuLink; 

– научиться создавать s – модели; 

– научиться решать дифференциальные уравнения с помощью состав-

ления их s – моделей и с помощью специального решателя. 

2. ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

2.1. Пакет Simulink 

Пакет является ядром интерактивного программного комплекса, пред-

назначенного для имитационного моделирования линейных и нелинейных 

динамических систем и устройств, представленных своей функциональной 

блок-схемой, именуемой s-моделью или просто моделью.  

Для построения функциональной блок-схемы моделируемых устройств 

SimuLink имеет обширную библиотеку блоков SimuLink Library Browser и 

удобный редактор блок-схем. Он основан на графическом интерфейсе поль-

зователя и по существу является типичным средством визуального програм-

мирования.  

Запуск пакета SimuLink можно произвести выбрав в главном окне ко-

манду File>New>Model или нажав соответствующую пиктограмму на панели 

инструментов.  

В первом случае откроется окно пакета Simulink, в котором создается 

s-модель и чтобы открыть библиотеку блоков необходимо выбрать в меню 

этого окна команду View>Library browser или нажать пиктограмму Library 

Browse.  

Во втором случае откроется библиотека блоков SimuLink Library 

Browse и чтобы открыть окно, в котором будет создаваться s-модель необхо-

димо выбрать в меню команду File>New>Model или нажать пиктограмму 

Create a new model. 

Рассмотрим некоторые разделы библиотеки блоков пакета SimuLink. 

1. Раздел Sourses содержит блоки — источники воздействий. Блоки ис-

точников воздействий (сигналов) имеют настолько очевидные обозначения, 

что не имеет смысла приводить их названия .  

2. Раздел Sinks — содержит блоки регистрирующих компонентов (при-

емники). Среди них можно выделить: 

- Блоки, играющие роль смотровых окон: Scope - выводит график зави-

симости величины, подаваемой на его вход от модельного времени; XY Graph 
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- обеспечивает построение графика зависимостей одной моделирующей ве-

личины от другой; Display - отображает численное значение входной величи-

ны; 

- Блоки для сохранения результатов: 

To file - cохранение результатов моделирования в файл; To Workspase - 

cохраняет результаты в рабочем пространстве; 

- Блок управления моделированием Stop Simulation, позволяющий пре-

рвать моделирование при выполнении некоторых условий; блок срабатывает 

в случае, если на его вход поступает ненулевой сигнал. 

3. Раздел Continuous  содержит перечень линейных блоков: Integrator - 

идеальное интегрирующее звено; Derivative – идеальное дифференцирующее 

звено; Transfer Fcn - определение линейного звена через задание его ПФ. 

4. Раздел  Маth Operation содержит перечень блоков математических 

операций: Gain – звено усилитель; Sum – звено сумматор; Product - звено, 

осуществляющее перемножение двух величин; Math Function позволяет за-

дать для преобразования входного сигнала элементарные не тригонометри-

ческие  и не гиперболические функции, такие как вычисление экспоненты, 

натурального  и десятичного логарифмов, возведение в степень, извлечение 

квадратного корня и т.д.; Trigonometric Function обеспечивает преобразова-

ние входного сигнала с помощью одной из тригонометрических функций: 

sin, cos, tan.      

5. Раздел Signal Routing содержит перечень блоков, преобразующих 

сигнал и вспомогательные блоки. Среди них блоки: Mux – выполняет объ-

единение входных величин в один выходной вектор; Demux – выполняет об-

ратную функцию – разделяет входной вектор на заданное число компонен-

тов; Manual Switch  - позволяет вручную переключать входы с помощью 

двойного щелчка мыши. 

5. Раздел User-Defined Functions позволяет реализовать функции, со-

здаваемые пользователем.  

Используя библиотеку блоков, пользователь с помощью мыши (для 

этого используется технология Drag-and-Drop (перетащи и вставь) переносит 

нужные компоненты с палитр на рабочий стол пакета SimuLink и соединяет 

линиями входы и выходы блоков. Таким образом, создается блок-схема си-

стемы или устройства. 

Для настройки параметров блока следует после установки блока два-

жды щелкнуть мышью на его изображении. При этом появится окно пара-

метров настройки блока.  

Чтобы соединить линией выход одного блока со входом другого необ-

ходимо подвести курсор к нужному выходу блока, нажать левую кнопку 

мыши и, не отпуская кнопку, переместить курсор ко входу другого блока и 

затем отпустить кнопку мыши. 

Чтобы образовать ответвление от существующей линии, необходимо 

установить курсор в точку ответвления, нажать клавишу Ctrl и левую кнопку 

мыши и удерживая их нажатыми провести линию. 
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2.2. Создание s - моделей в пакете Simulink 

Рассмотрим создание s – моделей систем, объектов, процессов и т.д., 

которые описываются дифференциальными уравнениями. 

Пример1 

Дано уравнение  

)20)((4.0)(  tTtT ,  90)0( T ,                                (1) 

которое описывает закон охлаждения тела разогретого до температуры Т=900 

и помещенного в среду температуры Т=200. Требуется построить зависи-

мость  Т(t) на интервале времени  ]15;0[t . 

Для построения схемы решения (рис. 1) (s – модели) уравнения (1) в 

Simulink используется блок Integrator (раздел Continuous). На его вход пода-

ется производная, а на выходе получают величину Т. Начальное условие за-

дается в окне настройки блока Integrator в строке редактирования Initial con-

dition. 

 
рис. 1 

 

Блоки Sum (сумматор) и Gain (усилитель) (раздел Math Operations) 

необходимы для формирования значения )(tT  в соотствии с ОДУ. 

Для получения постоянного сигнала )(18 t  используется блок Constant 

(раздел Sources).  

Полученное значение T(t) подается на вход блока Scope (раздел Sinks) - 

приемник сигналов. При открытии данного блока появляется график реше-

ния (рис. 2). Установить масштабы осей, соответствующие полученному ре-

шению можно, нажав кнопку Autoscale (пиктограмма с изображением бинок-

ля). 

 
рис. 2 

Окно блока Scope отображающее графики сигналов имеет очень огра-

ниченные возможности по изменению внешнего вида окна и графиков. Фак-

тически можно изменять лишь масштаб отображения графиков, а команды 
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изменения цветов линий и фона окна, толщины линий, размера и типа шриф-

тов и т.п. недоступны. Чтобы получить доступ к этим возможностям необхо-

димо после проведения расчетов открыть окно блока Scope и в командном 

окне Command Window ввести следующие команды:  

set(0,'ShowHiddenHandles','On')                                                                 (2) 

set(gcf,’menubar’,’figure’)                                                                           (3) 

После выполнения этих команд в окне блока Scope появится строка 

меню (рис.2). Используя команды меню Edit>Figure Properties, Edit>Axes 

Properties и Edit>Current Object Properties можно изменить внешний вид окна, 

осей и самих графиков в соответствии со своими требованиями. 

Чтобы поместить в отчет требуемые графики необходимо в меню окна 

Scope выбрать Edit>Copy Figure. 

Перед выполнением расчетов необходимо предварительно задать время 

расчета (время моделирования). Задание параметров расчета выполняется в 

меню панели управления Simulation>Parameters. Время расчета задается ука-

занием начального (Start time) и конечного (Stop time) значений времени рас-

чета. Начальное время, как правило, задается равным нулю. Величина конеч-

ного времени задается пользователем исходя из условий решаемой задачи. 

Чтобы активизировать процесс моделирования созданной s-модели 

нужно вызвать команду  Simulation>Start или нажать пиктограмму Start 

simulation на панели инструментов. 

Пример 2 
Дано уравнение Дуффинга, которое демонстрирует возникновение сто-

хастических колебаний для ряда нелинейных задач, в частности хаотическую 

динамику цепи с нелинейной индуктивностью или продольный изгиб упру-

гой балки. Уравнение имеет вид 

)cos()()()( 3 tBtxtkxtx  .                                               (4) 

Динамика определяется параметрами k ,B, а также начальными услови-

ями. Варьируя параметры, можно наблюдать различные режимы движения: 

от периодических до хаотических. 

Пусть 5.2)0(,0)0(  xx , 3.0k , 2B , ]50;0[t . 

Для построения схемы решения (рис. 3) (s – модели) уравнения (4) в 

Simulink используется два блока Integrator (раздел Continuous). 

 
 

рис. 3 
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На вход блока Integrator подается вторая производная )(tx , а на выходе 

получается величина )(tx , которая подается на вход блока Integrator1. На вы-

ходе блока Integrator1 получается величина x(t). Начальные условия )0(),0( xx  

задаются в окнах настройки блоков Integrator и Integrator1 соответственно в 

строке редактирования Initial condition. 

 Для получения сигнала 2cos(t) используется блок Sine Wave (раздел 

Sources). Блок Sine Wave имеет следующие настройки: Amplitude – определя-

ет амплитуду синусоидального сигнала; Frequensy (rad/sec) – задает частоту 

колебаний в радианах в секунду, Phase (rad) – позволяет установить началь-

ную фазу в радианах. В нашем случае  Amplitude: 2, Frequensy (rad/sec): 1, 

Phase (rad): pi/2 (pi - число  = 3.1415926... – системная переменная). 

Для формирования сигнала )(3 tx  используется блок Fcn (раздел User-

Defined Functions), который позволяет ввести любую скалярную функцию от 

одного аргумента, выражающуюся через стандартные функции MATLAB . 

Выражение функции вводится в окне настройки блока. Для обозначения 

входного сигнала (аргумента функции) используется символ «u». 

Полученные значения x (t) и x(t) подаются на входы блока Scope (раз-

дел Sinks). Чтобы установить параметры осей блока Scope, необходимо на 

панели инструментов окна этого блока нажать пиктограмму Parameters и на 

вкладке General в области Axes в поле Number of  axes  указать количество 

координатных осей (подокон), которые необходимо вывести в одном окне. 

Для построения фазового портрета x (x) ДУ (рис. 5) используется блок 

XY Graph. Он имеет два входа: на первый подается сигнал, значения которого 

откладываются по горизонтальной оси графика, а на второй – по вертикаль-

ной оси. В окне настройки этого блока можно установить пределы изменений 

входных величин, внутри которых будет выводиться график зависимости 

второй величины от первой.  

Для изменения внешнего вида окна и графиков блока XY Graph исполь-

зуются также команды (2) и (3), а для копирования графика в отчет команда 

Edit>Copy Figure.  

Именно эти команды были использованы для представления графиков 

x (t) и x(t) (рис. 4) и x (x) (рис.5). 
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                                      рис.  4                                            рис.5 

 

2.3. Решатель дифференциальных уравнений в пакете SimuLink 

В системе MATLAB одну и ту же задачу можно решать целым рядом 

способов.  

SimuLink имеет специальный редактор дифференциальных уравнений, 

с помощью которого можно задать систему дифференциальных уравнений в 

форме Коши. Для получения доступа к решателю надо загрузить файл dee (в 

командном окне Command Window после знака приглашения  ввести ко-

манду dee). В результате будет выведено окно решателя (рис. 6), с примерами 

применения.  

 
рис. 6 

 

Ограничимся примером с именем deedemo1 (кликнем по нему мышью).  

Он выводит окно всего с двумя блоками: блоком vdp и блоком Scope, выпол-

няющим роль осциллографа. Первый блок решает заданное уравнение Ван-

дер-Поля, а второй отображает решение в виде временной зависимости. 

Двойной щелчок на блоке vdp открывает редактор дифференциальных урав-

нений. В этом окне можно модифицировать решаемые уравнения или ввести 

новые.  

Рассмотрим применение решателя для моделирования процессов, 

представленных в примерах 1,2. 

Пример 3.  Рассмотрим уравнение (1).  

Выберем в меню окна dee команду File>New>Model. В открывшееся 

окно перенесем блок DEE (рис. 7) и откроем редактор дифференциальных 

уравнений (двойной щелчок на блоке DEE).  
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рис. 7 

 

 
рис. 8 

 

В редакторе DEE   в соответствующих строках редактирования введено 

(рис. 8): 

Name: имя блока; 

# of inputs: количество входных сигналов; 

First order equations, f(x,u): правая часть заданного дифференциального 

уравнения; 

x0: начальное условие; 

Output Equations, f(x,u): переменная, значение которой нас интересует. 

Далее добавляем блок Scope (раздел Sinks) для отображения зависимо-

сти Т(t) (в нашем случае x(t)), задаем время расчета (моделирования), активи-

зируем процесс моделирования и т.д.  

Пример 4 
S-модель решения уравнений (4) будет иметь вид, представленный на 

рис. 9. 
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рис. 9 

 

 
рис.10 

 

В редакторе решателя (рис. 10) в соответствующих строках редактирования 

введено: 

Name: имя блока; 

# of inputs: количество входных сигналов; 

First order equations, f(x,u): правая часть заданного дифференциального 

уравнения (сигнал 2cos(t) обозначим u(1)); 

x0: начальные условия; 

Output Equations, f(x,u): переменные, значения которых нас интересует. 

Для получения сигнала u(1) т.е. 2cos(t) используется блок Sine Wave 

(раздел Sources).  

Далее добавляем блоки Scope, XY Graph (раздел Sinks) для отображения 

зависимостей x(t), )(tx  и )(xx  соответственно, задаем время расчета (модели-

рования), активизируем процесс моделирования и т.д.  

 

3. Объект исследования 

Объектом исследования является пакет Simulink системы MATLAB. 
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4. Задание на исследование 

1. Познакомится с интерфейсом пакета Simulink и его библиотекой 

блоков SimuLink Library Browser. 

2. Создать s- модель процесса охлаждения тела, представленного урав-

нением 

)10)((06.0)(  tTtT ,  60)0( T .                                        (5) 

Построить зависимость  Т(t) на интервале времени  ]100;0[t . Опреде-

лить температуру тела в момент в времени t=15 c . 

3. Выполнить задание 2 с помощью решателя дифференциальных 

уравнений. 

4. Создать s- модель уравнения Дуффинга (4). Построить зависимости 

x (t),x(t), x (x). Параметры k ,B, а также начальные условия подобрать самосто-

ятельно. 

5. Выполнить задание 4 с помощью решателя дифференциальных 

уравнений. 

6. Получить графическое решение дифференциального уравнения на 

промежутке ]5;0[t . 
23 2

3 2
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dt dt dt dt

 
     

 
,                           (6) 

2

2

0

2

t

d x

dt


 ,    
0

3
t

dx

dt 

 ,   
0

5
t

x

  

7. С помощью составления s-модели и решателя найти y(t) и 

y (t),y(t), y (y) дифференциальных уравнений первого и второго порядка соот-

ветственно. Уравнения выбираются в соответствии с таблицей 1. 

Табл. 1. 

 

Вариант Уравнение первого порядка Уравнение второго порядка 

s - модель с помощью 

решателя 

s - модель с помощью 

решателя 

1 6 6 6 6 

2 5 5 5 5 

3 2 2 2 2 

4 11 11 11 11 

5 4 4 4 4 

6 3 3 3 3 

7 8 8 8 8 

8 7 7 7 7 

9 10 10 10 10 

10 1 1 1 1 

11 9 9 9 9 
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Далее приведены дифференциальные уравнения для вариантов зада-

ния. Начальные условия и время моделирования выбрать самостоятельно. 

Уравнения первого порядка: 

1. 
42

52
`






yt

ty
y , )(oy …, nttt ...0  

2. 
2

2

)1(

)2(2
`






yt

y
y , )(oy …, nttt ...0  

3. 1`cossin  tyty , )(oy …, nttt ...0  

4. 02`)1( 322  tyyyt , )(oy …, nttt ...0  

5. tety 1` , )(oy …, nttt ...0  

6. 0ln` 2  tyyty , )(oy …, nttt ...0  

7. 0cos` 2  tytgtyy , )(oy …, nttt ...0  

8. 
t

y

t

y
y

2cos

22
`  , )(oy …, nttt ...0  

9. 04` 2  ytyty , )(oy …, nttt ...0  

10. tgy
y

t
y 

cos
` , )(oy …, nttt ...0  

11. )sin1(cos`cos 2 ttytyy  , )(oy …, nttt ...0  

 

Уравнения второго порядка: 

1. tty sin``  , )`(oy …, )(oy …, nttt ...0  

2. ``` yty  , )`(oy …, )(oy …, nttt ...0  

3. 1`)(```2 2  yyty , )`(oy …, )(oy …, nttt ...0  

4. ``2`)(1 2 yyy  , )`(oy …, )(oy …, nttt ...0  

5. 32 )()(`` yyyy  , )`(oy …, )(oy …, nttt ...0  

6. 22 4`)(3``2 yyyy  , )`(oy …, )(oy …, nttt ...0  

7. ``)(`` 22 yyyyy  , )`(oy …, )(oy …, nttt ...0  

8. 2`)(`ln`` yyyyyy  , )`(oy …, )(oy …, nttt ...0  

9. 34 )(`` ytyyt  , )`(oy …, )(oy …, nttt ...0  

10. )1(`)(2 2  yyy , )`(oy …, )(oy …, nttt ...0  

11. yyyttyy  3)(`` 2 , )`(oy …, )(oy …, nttt ...0  

 

5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

1. Запустить среду MATLAB (ярлык MATLAB на рабочем столе). По-

явится окно среды MATLAB. 

2. Изучить интерфейс пакета Simulink и его библиотеку блоков Sim-

uLink Library Browser. 
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3. Создать s- модель процесса охлаждения тела (уравнение (5)) в пакете 

Simulink. Получить в окне блока Scope график Т(t) на интервале времени  

]100;0[t . Для определения температуры тела в момент в времени t=15 c ис-

пользовать блок Display. 
Примечание. 
Для автоматической установки оптимального масштаба осей блока Scope 

необходимо на панели инструментов этого блока нажать пиктограмму с изобра-
жением бинокля. 

4. Создать s- модель уравнения Дуффинга (4). Построить зависимости 

x (t), x(t) блока Scope, x (x) в окне блока XY Graph. 

5. Создать s- модель и получить графическое решение дифференциаль-

ного уравнения (6) при заданных начальных условиях на промежутке ]5;0[t . 

6. С помощью решателя найти решение Т(t) уравнения (5). 

7. С помощью решателя найти решение x(t), x (t), )(xx  уравнения (4). 

8. Составить s- модель уравнения первого порядка и найти y(t). 

9. С помощью решателя найти y(t) уравнения первого порядка. 

10. Составить s- модель уравнения второго порядка и найти 

y(t), y (t), y (y). 

11. С помощью решателя найти y(t), y (t), y (y) уравнения второго по-

рядка. 

 

6. ТРЕБОВАНИЯ К ОФОРМЛЕНИЮ ОТЧЕТА 

 

Отчет должен содержать: 

1. Название и номер работы, цель работы. 

2. s – модель уравнения (5), график функции Т(t), значение Т(15); 

    s – модель уравнения (4) и графики функций x (t), x(t), x (x); 

   s – модель уравнения (6) и график функции x(t). 

3. Окна редактора решателя для дифференциальных уравнений (5) и (4) 

и график функции Т(t) и графики функций x (t), x(t), x (x) соответственно. 

4. s – модели уравнений первого и второго порядка, а также соответ-

ствующие им решения y(t) и y (t), y(t), y (y). 

5. Окна редактора решателя для дифференциальных уравнений первого 

и второго порядка, а также соответствующие им решения y(t) и y (t), y(t), 

y (y). 

 

7. КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

1. Назовите основные разделы библиотеки SimuLink Library Browser. 

2. Что такое s- модель? Как ее создать?  

3. Какие параметры редактирования имеет окно блока Scope? 

4. Как задать время расчета (время моделирования) модели? 

5. Что такое решатель дифференциальных уравнений пакета SimuLink?  
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ЛАБОРАТОРНАЯ РАБОТА № 4 

 

ИЗУЧЕНИЕ ПАКЕТА ПРИКЛАДНЫХ ПРОГРАММ 

CONTROL TOOLBOX 

 

1. ЦЕЛИ И ЗАДАЧИ ИССЛЕДОВАНИЯ 

Научиться исследовать динамические свойства линейных систем авто-

матического управления (САУ) с помощью пакета прикладных программ 

Control ToolBox системы MATLAB. Достижение поставленной цели связано 

с необходимостью решения следующих задач: 

- построить графики во временной и частотной области с помощью ин-

терактивного обозревателя LTI Viewer; 

- построить графики во временной и частотной области с помощью со-

ответствующих функций пакета Control ToolBox. 

 

1. ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

Анализ и синтез САУ сопряжены с большим объемом теоретических и 

экспериментальных работ по исследованию их динамики и точности. Систе-

ма MATLAB является одной из наиболее эффективных экспериментальных 

средств, позволяющих в диалоговом режиме быстро и наглядно получать не-

обходимые оценки качества САУ как во временной, так и в частотной обла-

стях: 

1. Исследовать устойчивость системы управления (запасы устойчиво-

сти по амплитуде и по фазе; 

2. Исследовать качество переходных процессов (вид переходного про-

цесса и его длительность, величину перерегулирования); 

3. Выбрать параметры звеньев системы, вид и характеристики обрат-

ной связи с целью обеспечения требуемых динамических свойств системы 

управления. 

Простота решения задач управления определяется наличием в 

MATLAB специального пакета прикладных программ Control ToolBox. 

Линейная САУ может быть представлена LTI – моделью (LTI – объект) 

и ввод ее в среду пакета Control возможен в трех формах – в форме матриц 

пространства состояния (SS - объект), в виде коэффициентов числителей и 

знаменателей передаточных функций (TF - объект) и в форме задания нулей, 

полюсов и коэффициента передачи системы (ZPK - объект). 

Пакет Control представляет собой широкий набор функций, осуществ-

ляющих анализ САУ с самых различных точек зрения и, прежде всего, опре-

деление откликов системы на внешние воздействия, как во временной так и в 

частотной области. Кроме того, пакет Control содержит LTI Viewer - обозре-

ватель LTI – объектов, который позволяет в интерактивном режиме строить 

необходимые для анализа системы графики во временной и частотной обла-

сти, причем для нескольких систем синхронно.  

Именно обозреватель LTI Viewer используется в пакете SimuLink для 

анализа линейных САУ, представленных s – моделью. 
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2.1. Средства системы MATLAB, позволяющие решать задачи анализа 

САУ, представленной s – моделью пакета SimuLink 

Для анализа САУ, представленных s – моделью необходимые графики 

во временной и частотной области стоятся с помощью интерактивного обо-

зревателя LTI Viewer. 

Для этого нужно: 

1. Выбрать в строке меню окна, в котором находится s-модель, 

пункт Tools>Linear analysis. При этом откроется два окна: Mod-

el_Inputs_and_Outputs (рис. 1) и LTI Viewer (рис. 2) 

 

                  
                        рис. 1                                                     рис. 2 

 

2. Подключить элементы Input Point  и Output Point (рис. 1) на вход 

и выход звена или системы (рис. 3а, рис. 3б, рис. 3в). 

Примечание.  

1. Элементы Input Point и Output Point также находятся в библиотеке 

SimuLink Library Browser  в разделе Control System Toolbox. 

2. Элементы Input Point  и Output Point можно поместить в любом месте 

системы. 

 
рис. 3а 

 

 
рис. 3б 

 

 
рис. 3в 
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3. Провести моделирование (меню Simulation>Start или кнопка Start 

simulation или Ctrl+T). 

4. Выбрать в строке меню окна LTI Viewer (рис. 2) пункт Simulink>Get 

linearized model.  

5. Далее в контекстном меню (рис. 4) окна LTI Viewer (щелкнуть пра-

вой кнопкой мыши в рабочей области окна) выбрать для построения: 

– переходной характеристики - Plot Types>Step; 

– импульсной характеристики - Plot Types>Impulse; 

– годографа Найквиста - Plot Types>Nyquist; 

– ЛАФЧХ - Plot Types>Bode; 

– карты расположения полюсов и нулей - Plot Types>Pole/Zero. 

 

 
рис. 4 

 

Примечание. 

LTI Viewer настроен таким образом, что после выполнения пункта 4 в окне 
сразу появляется переходная характеристика звена (системы). 

Для каждой из характеристик можно на их графиках отметить необхо-

димые для исследования точки. Например, для определения времени регули-

рования и перерегулирования (переходная характеристика) нужно в кон-

текстном меню выбрать Characteristics>Setting Time и Characteristics>Peak 

Response (рис. 5). 
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рис. 5                                                           рис. 6 

 

Если при этом щелкнуть левой кнопкой мыши на появившихся на гра-

фике точках, то появятся подсказки (рис. 6) со значением времени регулиро-

вания (Setting Time (sec)) и перерегулирования (Overshoot (%)). 

Для ЛАФЧХ и годографа Найквиста можно определить запасы устой-

чивости по амплитуде (Gain Margin (dB)) и по фазе (Phase Margin (deg)): 

Characteristics>Stability (All Crossings). 

При изменении параметров s – модели системы необходимо опять про-

вести моделирование и выбрать в строке меню окна LTI Viewer (рис. 2) пункт 

Simulink>Get linearized model. При этом в окне LTI Viewer появятся резуль-

таты анализа исходной системы и системы с измененными параметрами. 

Чтобы удалить не нужный график необходимо выбрать в строке меню окна 

LTI Viewer пункт Edit>Delete Systems, а затем в появившемся окне редакти-

рования выбрать из списка результатов моделирования тот, который нужно 

удалить.  

Чтобы поместить в отчет требуемые графики необходимо в главном 

меню окна LTI Viewer выбрать File>Print to Figure. В главном меню открыв-

шегося окна Figure выбрать Edit>Copy Figure. Открыть файл отчета и выпол-

нить команду «вставить», например Ctrl+V. 

2.2. Анализ САУ, представленной LTI-моделью (LTI – объект) в среде 

пакета Control в виде коэффициентов числителей и знаменателей передаточ-

ных функций (TF - объект). 

Функция tf(n,m) – создает модель передаточной функции звена и си-

стемы в целом, где n – вектор коэффициентов числителя передаточной функ-

ции, m – вектор коэффициентов знаменателя передаточной функции. 

Операции с передаточными функциями:  

+ и -   – сложение и вычитание (параллельное соединение); 

*         – умножение (последовательное соединение); 

\          – левое деление; 

/          – правое деление.  
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Кроме «арифметических» операций для образования передаточной 

функции системы, состоящей из последовательного или параллельного со-

единения звеньев могут использоваться функции series(w1,w2) и paral-

lel(w1,w2) соответственно, где  w1 и w2 передаточные функции последова-

тельно или параллельно соединенных звеньев, заданные оператором tf. 

Функция feedback(w, woc, 1) – применяется для образования переда-

точной функции замкнутой системы по известным передаточным функциям 

разомкнутой системы w  и цепи обратной связи woc. Значение - 1 – указыва-

ет вид обратной связи (-1 – отрицательная, +1 – положительная). В случае 

единичной отрицательной связи можно использовать команду feedback(w,1). 

Функции pole(w), zero(w) –  предназначены для определения полюсов и 

нулей передаточной функции w звена (системы), заданной оператором tf. 

Функция pzmap(w) – показывает расположение полюсов и нулей на 

комплексной плоскости S передаточной функции w звена (системы), задан-

ной оператором tf. 

Для нахождения временных откликов на внешние воздействия звена 

(системы), представленного передаточной функцией w, заданной оператором 

tf,  предусмотрены функции: 

impulse(w) – нахождение отклика звена (системы) на единичное им-

пульсное входное воздействие;  

step(w) – нахождение реакции звена (системы) на единичное ступенча-

тое воздействие; 

lsim(w,u,t) – определение реакции звена (системы) на входное воздей-

ствие произвольной формы, задаваемое в виде вектора его значений во вре-

мени.  

Для применения функции lsim(w,u,t) необходимо предварительно за-

дать вектор значений времени t, в которых будут заданы значения входного 

воздействия, а затем задать соответствующий вектор u значений входной ве-

личины в указанные моменты времени. 

Следующая группа функций представляет в частотной области реак-

цию на внешнее гармоническое воздействие звена (системы), представленно-

го передаточной функцией w, заданной оператором tf: 

bode(w) – строит графики ЛАЧХ и ЛФЧХ системы 

nyquist(w) – строит в комплексной плоскости график АФХ звена (си-

стемы). 
Примечание.  
Для всех указанных выше графиков выполняются те же команды кон-

текстных меню, что и в пункте 2.1.  

Создавать и исследовать LTI – модели можно в командном окне Com-

mand Window или в редакторе М-файлов, написав М-сценарий: 
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рис. 7 

 

Если после команды в М-сценарии не поставить «;», то ее результат 

отобразится в командном окне Command Window. Так, в представленном М-

сценарии (рис. 7) после команд в 1,2, 3 и 7 строках не стоят «;» и поэтому в 

командном окне Command Window мы можем видеть передаточные функции 

w1, w2, w3, w5.  

Для исследования LTI – моделей можно использовать также интерак-

тивный обозреватель LTI Viewer. Для этого в командном окне Command 

Window нужно ввести команду ltiview. После выполнения команды на экране 

появится окно LTI Viewer, в котором необходимо выбрать File>Import, а за-

тем с помощью мыши выделить в списке  Workspase имена исследуемых LTI 

– моделей. 

3. Объект исследования 

Объектом исследования является пакет прикладных программ Control 

ToolBox системы MATLAB. 

 

4. Задание на исследование 

Дана структурная схемы системы управления (рис. 8): 

 

 
рис. 8 

 

Необходимо составить s- модель и TF - модель системы управления 

(рис. 8), для которых построить карту полюсов и нулей замкнутой и разо-

мкнутой системы, переходную характеристику, ЛАФЧХ, годограф Найкви-

ста, а также найти реакцию системы на гармонический входной сигнал 

)sin(5.0)( ttx  . Найти значения полюсов и нулей замкнутой и разомкнутой си-

стемы, запасы по амплитуде и по фазе, время регулирования и перерегулиро-

вание. 
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Если система не устойчива, то подобрать такие параметры (коэф-

фициент передачи, постоянные времени), чтобы система была устойчива. 

Передаточные функции исследуемой системы выбираются соответ-

ственно варианту задания (таблица 1).  

Табл. 1 

 

Вариант s- модель TF - модель 

1 1 1 

2 2 2 

3 3 3 

4 4 4 

5 5 5 

6 6 6 

7 7 7 

8 8 8 

9 9 9 

10 10 10 

 

Далее приведены передаточные функции звеньев системы для вариан-

тов задания: 

 

Вариант 1. 
1

)(1
1

1




sT

K
sW , 

1
)(2

2

2




sT

K
sW , 

1

1
)(3

4

3






sT

sT
sW , где 201 K , 22 K , 

5.11 T , 22 T , 4.53 T , 5.24 T . 

Вариант 2. 1)(1 1  sTsW , 
)1(

)(2
2

2




sTs

K
sW , 

1
)(3

3

3




sT

K
sW , где 22 K , 

6.03 K , 05.01 T , 8.02 T , 1.03 T . 

Вариант 3. )1()(1 11  sTKsW , 
)1(

)(2
2

2




sTs

K
sW , 

1

)1(
)(3

4

33






sT

sTK
sW , где 

321 K , 162 K , 5.23 K , 5.11 T , 52 T , 5.13 T , 24 T . 

Вариант 4. 1)(1 KsW  , 
)1(

)1(
)(2

2

12






sTs

sTK
sW , 

1

1
)(3

4

3






sT

sT
sW , где 201 K , 

252 K , 5.11 T , 32 T , 5.03 T , 4.14 T . 

Вариант 5. 
1

)(1
1

1




sT

K
sW , 

)1(
)(2

2

2




sTs

K
sW , 

1
)(3

3

3




sT

K
sW , где 21 K , 

1.02 K , 5.13 K , 21 T , 5.12 T , 5.03 T . 

Вариант 6. 
1

)(1
1

1




sT

K
sW , 

)1(

)1(
)(2

3

22






sTs

sTK
sW , 

1
)(3

4

3




sT

K
sW , где 5.11 K , 

22 K , 73 K , 21 T , 5.02 T , 33 T , 4.14 T . 

Вариант 7. )1()(1 11  sTKsW , 
)1(

)(2
2

2




sTs

K
sW , 

1
)(3

3

3




sT

K
sW , где 51 K , 

152 K , 123 K , 8.01 T , 5.02 T , 23 T . 
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Вариант 8. 
)1(

)(1
1

1




sTs

K
sW , 

1

1
)(2

3

2






sT

sT
sW , 

1

)1(
)(3

5

42






sT

sTK
sW , где 51 K , 

352 K , 5.01 T , 22 T , 2.33 T , 5.14 T , 2.05 T . 

Вариант 9. 
)1(

)1(
)(1

2

1






sTs

sT
sW , 

1
)(2

3

1


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sT

K
sW , 

1
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)(3

5
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


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sW , где 1001 K , 

6.52 K , 31 T , 5.02 T , 5.23 T , 54 T , 25 T . 

Вариант 10. 
)1(

)(1
1

1




sTs

K
sW , 2)(2 KsW  , 

1

)1(
)(3

3

23






sT

sTK
sW , где 1.01 K , 

22 K , 6.03 K , 21 T , 5.02 T , 1.03 T . 

 

5. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

 

1. Создать s-модель заданной системы управления в пакете Simulink 

(элементы находятся в библиотеке). 

Для этого необходимо: 

1.1. Запустить среду MATLAB (ярлык MATLAB на рабочем столе). 

Появится окно среды MATLAB. 

1.2. Создать файл для моделирования в пакете Simulink (меню 

File>New>Model).  Появится окно пакета Simulink, в котором создается s-

модель (все дальнейшие команды будут относиться к окну Simulink). 

1.3. Открыть библиотеку элементов Simulink (меню View>Library 

browser или кнопка Library Browser). 

1.4. Из блоков, хранящихся в библиотеке Simulink построить s-модель 

(для этого используется технология Drag-and-Drop (перетащи и вставь)).  

Блоки Integrator,Derivative, Transfer Fcn для построения моделей дина-

мических звеньев находятся в разделе Continuous, блок Gain для создания 

пропорционального звена и блок Sum для создания сумматора в разделе Math 

Operations.  

Для настройки параметров блока следует после установки блока два-

жды щелкнуть мышью на его изображении. При этом появится окно пара-

метров настройки блока.  

Чтобы соединить линией выход одного блока со входом другого необ-

ходимо подвести курсор к нужному выходу блока, нажать левую кнопку 

мыши и, не отпуская кнопку, переместить курсор ко входу другого блока и 

затем отпустить кнопку мыши. 

2. Получить карту полюсов и нулей (для замкнутой и разомкнутой си-

стемы), годограф Найквиста (разомкнутая система), ЛАФЧХ (разомкнутая 

система) и переходную характеристику (замкнутая система). Оценить устой-

чивость системы, определить запасы устойчивости, время регулирования, 

перерегулирование. 

Примечание. 

Для быстрого замыкания и размыкания обратной связи можно исполь-

зовать блоки раздела Signal Routing: Manual Switch  (блок позволяет вручную 

переключать входы с помощью двойного щелчка мыши) и Grоund (рис. 9)  
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рис. 9 

 

3. Получить реакцию системы на гармонический входной сигнал 

)sin(5.0)( ttx  . 

Источник сигнала реализуется с помощью блока Sine Wave и находится 

в разделе Sources. Блок Sine Wave имеет такие настройки: Amplitude – опре-

деляет амплитуду синусоидального сигнала; Frequensy (rad/sec) – задает ча-

стоту колебаний в радианах в секунду.  

Для просмотра переходного процесса используется приемник сигналов 

- блок Scope в разделе Sinks. 

Примечание. 

1. Для автоматической установки оптимального масштаба осей блока 

Scope необходимо на панели инструментов этого блока нажать пиктограмму 

с изображением бинокля. 

2. Окно блока Scope отображающее графики сигналов имеет очень 

ограниченные возможности по изменению внешнего вида окна и графиков. 

Фактически можно изменять лишь масштаб отображения графиков, а коман-

ды изменения цветов линий и фона окна, толщины линий, размера и типа 

шрифтов и т.п. недоступны. Чтобы получить доступ к этим возможностям 

необходимо после проведения расчетов открыть окно блока Scope и в ко-

мандном окне Command Window MATLAB ввести следующие команды:  
set(0,'ShowHiddenHandles','On') 

set(gcf,'menubar','figure') 

После выполнения этих команд в окне блока Scope появится меню. Ис-

пользуя команды меню Edit>Figure Properties, Edit>Axes Properties и 

Edit>Current Object Properties можно изменить внешний вид окна, осей и са-

мих графиков в соответствии со своими требованиями. 

4. Создать TF - модель системы управления. 

Для этого необходимо: 

4.1. Запустить среду MATLAB (ярлык MATLAB на рабочем столе). 

Появится окно среды MATLAB. 

4.2. Создать М-файл (меню File>New>M-file).  Появится окно редакто-

ра отладчика, в котором создается файл-сценарий. 

5. Для системы управления представленной LTI – моделью определить 

нули и полюсы замкнутой и разомкнутой передаточной функции системы.  

Получить карту полюсов и нулей (для замкнутой и разомкнутой систе-

мы), годограф Найквиста (разомкнутая система), ЛАФЧХ (разомкнутая си-
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стема), переходную характеристику (замкнутая система) и реакцию системы 

на гармоническое входное воздействие (замкнутая система). 

Оценить устойчивость системы, определить запасы устойчивости, вре-

мя регулирования, перерегулирование. 

Примечание. 

Чтобы посмотреть в командном окне Command Window созданные пе-

редаточные функции или значения ее полюсов/нулей нужно после соответ-

ствующей команды не ставить «;». Для вывода значений переменной или 

текста в командное окно Command Window используется также команда 

disp[<переменная или текст в апострофах>].  

 

6. ТРЕБОВАНИЯ К ОФОРМЛЕНИЮ ОТЧЕТА 

 

Отчет должен содержать: 

1. s – модель системы управления; карты нулей и полюсов замкнутой и 

разомкнутой системы, частотные характеристики и значения запасов устой-

чивости;  переходную характеристику и значения времени регулирования и 

перерегулирования; реакцию системы на гармонический входной сигнал. 

2. Файл-сценарий создания TF – модели системы управления и ее ис-

следования; значения нулей и полюсов замкнутой и разомкнутой системы; 

построенные в одном графическом окне Figure: частотные, переходная ха-

рактеристики, реакция системы на гармонический входной сигнал и карты 

нулей и полюсов замкнутой и разомкнутой системы; значения запасов устой-

чивости, времени регулирования и перерегулирования. 

 

7. КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

1. Как получить частотные и временные характеристики для системы 

управления, представленной s – моделью? 

2. Как получить частотные и временные характеристики для системы 

управления, представленной LTI – моделью? 

3. Как определить по значение времени регулирования и перерегулиро-

вание по переходной характеристике, полученной в системе MATLAB? 

4. Как определить по значения запасов устойчивости по частотным ха-

рактеристикам, полученным в системе MATLAB? 

5. Как создать передаточную функцию 
15.0

10
)(




s
sW ? 
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ЛАБОРАТОРНАЯ РАБОТА № 5 

 

ВЫБОР ИСПОЛНИТЕЛЬНОГО ДВИГАТЕЛЯ ДЛЯ 

ЭЛЕКТРИЧЕСКОГО СЛЕДЯЩЕГО ПРИВОДА ПОСТОЯННОГО ТОКА 

 

ЦЕЛЬ ИССЛЕДОВАНИЯ 

Отработка навыков работы с пакетами расширения системы MATLAB; экспери-

ментальное исследование электрического следящего привода (ЭСП) постоянного тока. 

Достижение поставленной цели связано с необходимостью решения следующих 

задач: 

– расчет элементов силовой системы привода, который предусматривает выбор 

исполнительного двигателя и расчет редуктора. 

– построение математического описания и симулинк-схем силовой системы при-

вода и замкнутого ЭСП. 

 

ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

1.1 Формирование требований к следящей системе 

Рассмотрим электрический следящий привод (ЭСП) постоянного тока с незави-

симым возбуждением. 

Проектирование ЭСП производится на основе технического задания (ТЗ). В об-

щем случае ТЗ содержит требования к устойчивости, точности, быстродействию, коле-

бательности, перерегулированию. В ТЗ указываются ограничения по напряжению пита-

ния, току, моменту, мощности, массе и габаритам конструкции, требования к техноло-

гичности, стоимости и др. В ТЗ задаются характеристики полезного сигнала (класса 

входных сигналов) и возмущающих воздействий, а также задаются параметры полезной 

нагрузки. 

Рассмотрим проектирование ЭСП на основе следующих требований: 

1) предельные характеристики полезного сигнала: 

- максимальная скорость: m 1.0 /рад с  ; 

- максимальное ускорение: 
2

m 1.0 /рад с  ; 

2) требование по точности в режиме слежения: модуль установившейся ошибки 

не должен превышать 4 мрад; 

3) требование по быстродействию и колебательности в режиме переброски: 

- время перемещения нагрузки на угол 1.57 рад (90 град) – не более 2 с; 

- перерегулирование – не более 10%. 

4) момент инерции нагрузки, приведенный к валу двигателя  

; 

5) момент нагрузки 

; 

2.2 Выбор исполнительного двигателя 

В силовых следящих приводах широко применяются исполнительные двигатели 

(ИД) постоянного тока с независимым возбуждением. Параметрами, по которым выби-

рается ИД, являются мощность и момент. Сложность выбора ИД и передаточного числа 

редуктора обусловлена тем, что энергетические характеристики силового системы при-

вода определяются не только полезной нагрузкой, но и инерционностью ротора двигате-

ля и вращающихся частей редуктора, а также моментом сопротивления движению в ме-

ханической передаче от ИД к нагрузке. 

Исходя из потребного значения потребной выходной мощности, выбираем двига-

тель постоянного тока серии ЭДМ-20, который с большим запасом обеспечит отработку 

сигналов из заданного класса. Отметим, что малоинерционные реверсивные электродви-

гатели постоянного тока с постоянными магнитами и гладким якорем серии ЭДМ имеют 
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высокие точностные характеристики, отличаются высоким быстродействием, малым 

напряжением трогания, низким моментом инерции. 

Характеристики двигателей серии ЭДМ приведены в таблицах 1, 2. 

 

Табл. 1 

 

Технические характеристики двигателя ЭДМ-10 

Номинальная мощность, Вт 90 

Момент номинальный, Н·м 0,29 

               пусковой, Н·м 2,9 

Номинальная частота вращения, об/мин 3000 

Номинальное напряжение, В 27 

Номинальный ток, А 5,2 

Сопротивление обмотки якоря при 20ºС, Ом 0,9 

Момент инерции якоря, кг·м2 0,000028 

Индуктивность обмотки якоря, Гн 0,6*10-3 
 

 

Табл. 2 

 

Технические характеристики двигателя ЭДМ-20 

Номинальное напряжение питания 27 В 

Номинальная мощность 400 Вт 

Номинальная ток 25 А 

Номинальный момент 1.3 Н∙м 

Номинальная частота вращения 3000 об/мин 

Момент инерции якоря 0.0003 кг∙м2 

Сопротивление обмотки якоря при 20ºС 0.15 Ом 

Электромагнитная постоянная времени 0.0015 с 

Пусковой момент 13 Н∙м 

Частота вращения холостого хода 3900 об/мин 

Коэффициент противоЭДС 0.077 В∙с/рад 

Коэффициент момента двигателя 0.07 Н∙м/А 

 

Примечание. 

В случае необходимости можно рассчитать недостающие коэффициенты модели 

ИД. Покажем, как определяются коэффициенты Се и См в случае, если они не указаны в 

паспорте на двигатель. Находим значение Се из уравнений статики, т.е. установившегося 

режима вращения с номинальной скоростью 

 
откуда 

 
Находим значение См. из зависимости для движущего момента при отсутствии 

сил трения  

 
откуда 

 
Приведем описание электродвигателей ЭДМ-14 и ЭДМ-20, которое представлено 

на сайте производителя. 



 45 

Табл. 3. 

 

Характеристики электродвигателей серии ЭДМ 

Серия Мощность, кВт Частота, об./мин Напряжение, В КПД, % 

ЭДМ-10 
0.09 3000 27 65 

ЭДМ-14 
0.18 3000 27 65 

ЭДМ-20 
0.4 3000 27 65 

 

ТЕХНИЧЕСКИЕ ХАРАКТЕРИСТИКИ 

Режим работы продолжительный; 

Схема соединений двухпроводная; 

Исполнение водонепроницаемое пылебрызгозащишенное; 

Напряжение трогания на холостом ходу 1,5 В, не более; 

Направление вращения реверсивное; 

Масса ЭДМ-14 - 7,4 кг; ЭДМ-20 - 14 кг 

Габаритные размеры, мм 

ЭДМ-14: 165 х 236; ЭДМ-20: 190 х 300; 

 

2.3 Расчёт редуктора 

Двигатели постоянного тока неудовлетворительно работают на малых скоростях. 

Рабочими режимами для них являются скорости порядка тысяч оборотов в минуту (сот-

ни радиан в секунду). Например, для двигателей серии ЭДМ рабочей является частота 

вращения 3000 об/мин (314.16 рад/с). 

Потребные для следящей системы (например, для системы автоматического со-

провождения маневренной воздушной цели) скорости лежат в диапазоне единиц рад/с, 

при этом 1 рад/с соответствует 9.55 об/мин. Поэтому нагрузка присоединяется не непо-

средственно к валу двигателя, а через механический редуктор, имеющий довольно 

большое передаточное отношение (несколько сотен). 

Отметим, что редуктор многократно увеличивает вращающий момент, развивае-

мый приводом на нагрузке, и при этом уменьшает возмущения на двигатель со стороны 

нагрузки. Такие возмущения могут быть обусловлены, например, стрельбой артиллерий-

ского автомата, пусками ракет, порывами ветра и т.д. 

Выражение для передаточного числа редуктора, обеспечивающего максимальное 

быстродействие системы, имеет вид: 

 . .

. .

;
ДВ Н

ОПТ

О МАКС

n







  (1) 

Здесь: . .ДВ Н


 – скорость ротора двигателя; . .О МАКС


 – максимальная скорость по-

ворота нагрузки. 

Согласно формуле (1), по паспортной частоте вращения ЭДМ-20 рассчитываем 

передаточное число редуктора: 

3000 2

60
314.

1
ОПТ

n



 

 
 
 

 
Исходя из найденного общего передаточного отношения механической передачи, опре-

делим число кинематических пар редуктора с помощью диаграммы. 

 

https://www.eds-msk.ru/?site_page=motors_catalog&model_id=286#CatalogModelId_286
https://www.eds-msk.ru/?site_page=motors_catalog&model_id=286#CatalogModelId_286
https://www.eds-msk.ru/?site_page=motors_catalog&model_id=286#CatalogModelId_286
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При lg( ) lg(314) 2.50n    следует принять общее число кинематических пар (сту-

пеней) редуктора 4n  . 

Определим коэффициент полезного действия редуктора. КПД каждой ступени со-

ставляет 0.95–0.97. Примем 0.95ñò  . Тогда КПД редуктора:  

n

Ð ñò  ; 40.95 0.815Ð   . 

Виды механических редукторов различных типов представлены на рисунке 

 

Рассмотрим МО функционирования ИД в переходных и установившихся режимах 

при нулевых начальных условиях. МО ИД с жесткой кинематической передачей и ре-

дуктором без люфта представляет собой систему обыкновенных дифференциальных 

уравнений, а также алгебраических уравнений и неравенств вида 

н

н

н
н

m m

;

;

/ ;

;

.

e

m

di
L U i R C

dt

d
J C i h M

dt

q

d

dt

U U U






 





      


     



 



  



 

где U  - управляющее напряжение на якорной обмотке, mU
 - напряжение источника пи-

тания; i  - ток якоря; R, L - активное сопротивление и индуктивность якоря, соответ-

ственно; eC
 - коэффициент противоэдс; M

C
 - коэффициент, определяющий зависимость 

развиваемого момента от тока;  φ, ω, J  – угол, угловая скорость и приведенный к рото-

ру двигателя момент инерции нагрузки, соответственно; h  - коэффициент вязкого тре-

ния;   
q

  – передаточное отношение редуктора; M  - момент нагрузки  ( M const ). 

Рис. 1. Simulink-схема ИД с выходом по скорости 

 

В одномассовой модели двигателя нагрузка характеризуется приведенным к валу 

двигателя моментом инерции подвижных частей привода, который рассчитывается по 

формуле 

пр дв 2

нJ

n
J J  . 
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Параметры Simulink-схемы ИД следующие: 

 

%Параметры ЭДМ-10 и нагрузки 

R=0.9; 

L=0.6*10^-3; 

q=1/314; 

n=1/q;         %передаточное отношение редуктора 

Ce=0.071; 

Cm=0.056; 

Jn=30; 

Jd=0.000028; 

J=Jd+Jn/(n^2); %приведенный момент инерции нагрузки 

Ktr=0.1; 

Mn=63; 

Mpr=63/n;      %приведенный момент сопротивления нагрузки  
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ЛАБОРАТОРНАЯ РАБОТА №6 

 

МОДЕЛИРОВАНИЕ ДИНАМИЧЕСКИХ ИСПЫТАНИЙ 

ДВИГАТЕЛЯ ПОСТОЯННОГО ТОКА В ПАКЕТЕ SIMULINK 

 

ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

Заметим, что представленная выше линейная одномассовая модель ИД учитывает 

вязкое трение на нагрузке, но не учитывает такие факторы как нежесткость механиче-

ской передачи, люфт редуктора, сухое трение в щеточно-коллекторном узле и в нагрузке, 

ограничение по развиваемому моменту. 

Рассмотрим анализ динамических характеристик двигателя, работающего на инерцион-

ную нагрузку. 

 

Рис. 2. Пример переходного процесса по скорости ротора ИД 

 

Видно, что при подаче на вход ИД номинального напряжения U = 27 В ротор раз-

гоняется до установившейся скорости 475 рад/c. Время переходного процесса 0.041 с. 

 

 
Рис. 3. Пример осциллограммы угла нагрузки в режиме переброски 
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Рис. 4. Пример осциллограммы угловой скорости якоря в режиме переброски 

 

Осциллограммы показывают, что в режиме переброски при подаче на якорную 

обмотку двигателя прямоугольного импульса напряжения 27 В длительностью 1.75 с 

нагрузка поворачивается на угол 2.03 рад (на угол 1150). Таким образом, результаты вир-

туальных динамических испытаний двигателя показывают, что он способен обеспечить 

заданный в ТЗ режим переброски нагрузки. 

Выполним анализ динамических возможностей силовой системы привода в ре-

жиме слежения. Рассмотрим отработку разомкнутым приводом эквивалентного синусо-

идального электрического сигнала (напряжения на якорной обмотке) и оценим вносимое 

нагруженным двигателем фазовое запаздывание. 

 

 

 

 

 

 

 

 

 

 

 

Рис. 5. Пример осциллограммы отработки гармонического сигнала: 

а) слева: синий – входной сигнал амплитудой 27В; красный – выход по углу; 

б) справа: скорость вращения вала двигателя. 

 

Заметим, что при сопоставлении осциллограммы разных физических величин 

(например, напряжения и угла) следует их нормировать, т.е. преобразовать к безразмер-

ному виду путем деления на характерную базисную величину (например, на напряжение 

питания, максимальный угол поворота нагрузки). 

По осциллограммам сигналов на входе и выходе ИД можно оценить инерцион-

ность силовой системы путем расчета вносимого ею фазового запаздывания на частоте 

полезного гармонического сигнала. 

Выполним оценку инерционности нагруженного двигателя, рассчитав фазовый 

сдвиг по осциллограммам сигналов на входе и выходе ИД. Пусть при входном сигнале 

типа эквивалентной синусоиды вида 

   1 sin 1v t = t   

осциллограммы сигналов на входе и выходе ИД имеют вид 
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Рис. 6. Экспериментальное измерение фазового сдвига 

 

По измеренным отрезкам 0a и 0b рассчитывается фазовый сдвиг   в градусах 

по соотношениям 

 

 
Отметим, что в замкнутом ЭСП фазовое запаздывание компенсируется средства-

ми коррекции: замыканием контура управления по регулируемой координате (т.е. реали-

зацией принципа управления по отклонению); использованием элементов с дифферен-

цирующими свойствами (ПД или ПИД-регулятора, дифференцирующего фильтра), вве-

дением местной обратной связи по скорости и др. Средства коррекции в ЭСП вносят не-

обходимое фазоопережение на частоте полезного сигнала. Замкнутый высокоточный 

ЭСП в рабочей полосе частот должен иметь малый фазовый сдвиг, который может быть 

указан в ТЗ. Фазовый сдвиг может выступать в качестве критерия точности следящего 

привода. 

ВЫВОДЫ 

 

1. В режиме переброски нагрузка поворачивается на угол 2.03 рад (115 град) за 

время 1.75 с, т.е. двигатель ЭДМ-20 с заданной нагрузкой способен обеспечить ТЗ. 

2. В режиме слежения разомкнутый привод не способен с малым фазовым запаз-

дыванием отработать заданный в ТЗ гармонический сигнал периода 6.28 с. Вносимый 

фазовый сдвиг на частоте полезного сигнала составляет более 100 град. Таким образом, 

требуются замыкание привода по регулируемой величине и синтез регулятора.  

 

ЗАДАНИЕ НА РАБОТУ 

 

1. Изучить теоретическую часть. 

2. Ознакомиться с ТЗ на разработку ЭСП. 

3. Выполнить расчет силовой системы привода: 

- выбрать ИД на основе энергетического анализа; 

- рассчитать редуктор; 

4. Построить математическое описание ИД третьего порядка с приведенными мо-

ментом инерции нагрузки и моментом нагрузки. 

5. Построить Simulink-схему ИД с выходом по углу (в схеме учесть наличие редук-

тора). 

6. Выполнить экспериментальную проверку правильности выбора двигателя и оце-

нить динамические возможности ИД в режимах переброски и слежения. 

7. Оформить отчет, в котором отразить теоретические сведения, результаты экспе-

риментальной работы (скриншоты осциллограмм сигналов) с комментариями, предста-

вить выводы по работе. 
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КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

1. На основе каких законов физики строится МО функционирования ИД в переход-

ных и установившихся режимах? 

2. Что представляет собой МО функционирования ИД и его Simulink-схема? Каковы 

начальные условия функционирования? 

3. Как определяются приведенные к валу двигателя параметры механической подси-

стемы: момент инерции нагрузки, момент нагрузки? 

4. Назовите характерные режимы работы ЭСП? 

5. Каковы требования ТЗ на проектирование ЭСП?  

6. Что такое эквивалентный синусоидальный входной сигнал? Как он определяется 

по заданным в ТЗ предельным значениям скорости и ускорения? 

7. Как выбирается ИД? 

8. Зачем нужен редуктор? Как он рассчитывается? Чему равен вращающий момент 

на выходе редуктора? 

9. Как проверяется правильность выбора двигателя? 

10. Как определяется фазовое запаздывание, вносимое элементом автоматической 

системы? 

11. Каковы способы коррекции, применяемые в следящих приводах? 

12. Осциллограммы каких сигналов ИД регистрируются для анализа его динамики? 

Какие показатели динамики оцениваются в виртуальном испытательном стенде? 
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ЛАБОРАТОРНАЯ РАБОТА №7 

 

АНАЛИЗ УСТОЙЧИВОСТИ ЭЛЕКТРОПРИВОДА 

В СИСТЕМЕ MATLAB 

 

ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

Анализ устойчивости и качества регулирования замкнутой линейной системы в 

пакете Simulink выполняется с помощью динамических диаграмм. Построение диа-

грамм, как правило, включает следующие операции. 

1. Отклик во времени: 

 step - отклик на единичный скачок (переходная характеристика); 

 impulse - отклик на единичный импульс – импульсная переходная характе-

ристика (весовая функция). 

2. Частотный отклик: 

 bode - диаграмма Боде частотного отклика (АЧХ и ФЧХ); 

 nyquist  - диаграмма Найквиста (АФЧХ на комплексной плоскости); 

3. Построение карты полюсов и корней системы. 

 

Подготовка Simulink-схемы ЭСП к использованию инструмента Linear Analysis 

Tool производится следующим образом: с помощью правой кнопки мыши наводится 

курсор на вход, а затем на выход системы. В появившемся контекстном меню надо вы-

брать Linear Analysis Points и установить соответствующие маркеры на входе и выходе 

системы. 

Путь для запуска процедуры анализа динамики линейной системы следующий: 

Analysis/ Control Design/ Linear Analysis. 

 
 

Рис. 1. Simulink-схема линейного ЭСП с маркерами на входе и выходе 

 

Параметры схемы следующие. 

 

R=0.9; 

C=1000000; 

q=1/314; 

n=1/q; 

ce=0.071; 

cm=0.056; 

L=0.0006; 

Jn=30*2; 

Jd=0.000028; 
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J=Jd+Jn/(n^2); 

Ktr=0.7; 

ki=0.00013; 

kw=0.00001; 

 

 
 

Рис. 2. Запуск инструмента Linear Analysis Tool 

 

Логарифмические АЧХ и ФЧХ привода представлены на рисунке. 

 

 
 

Рис. 3. Запас устойчивости по фазе: 10.5 град 
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Рис. 4. Запас устойчивости по амплитуде: 19.2 дБ. 

 

Карта корней характеристического многочлена на комплексной плоскости пред-

ставлена на рисунке. 

 

 
Рис. 5. Карта корней характеристического многочлена на комплексной плоскости 

 

Полином знаменателя передаточной функции замкнутой системы, соответствую-

щий характеристическому уравнению (ХУ) системы, также называют характеристиче-

ским. Полюса системы являются решения ХУ. Характеристический полином полностью 

и однозначно отображает свойства системы при свободном движении. 

Расположение корней ХУ испытуемой системы следующее (рис. 5): 

- два комплексно-сопряженных корня слева от границы устойчивости (ось орди-

нат); 

- один действительный корень слева от границы устойчивости. 
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Таким образом, все корни ХУ являются левыми (имеют отрицательные действи-

тельные части). В соответствии с теоремами А.М. Ляпунова об устойчивости линейной 

системы это означает, что ЭСП является устойчивым. Однако очень близкое к колеба-

тельной границе устойчивости расположение корней ХУ указывает на высокую колеба-

тельность системы и малые запасы устойчивости. Это подтверждается видом переход-

ной и весовой функций. 

По корням характеристического полинома вычисляются степень устойчивости и 

степень колебательности, которые характеризуют запасы устойчивости и качество пере-

ходного режима. Эту информацию можно использовать в процедуре оптимизации регу-

лятора методом штрафных функций. При этом предполагается, что оптимизация услов-

ная, т.е. заданы функциональные ограничения, которые ограничивают допустимую об-

ласть в пространстве параметров регулятора. 

Эти ограничения обусловлены требованиями к показателям: 

- точности слежения abs(е)<=4 мрад; 

- степени устойчивости abs(h)> =0.01 

- степени колебательности abs(m)<=50; 

- уровню сигнала управления abs(U) <=27 В. 

 

ПРИМЕР. 

Пример текста программы условной оптимизации параметров модели ЭСП пятого 

порядка в среде Матлаб дан ниже. Предполагается, что Simulink-схема ЭСП реализована 

в векторной форме с использованием векторов А, В, k. 

k=[1 0 0 kw ki];          %вектор коэффициентов обратных связей ЭСП 

p=eig(A-B*k);             %вычисление корней характеристического полинома 

h= - max(real(p));        %вычисление степени устойчивости  

m = max(imag(p)/real(p))   %вычисление степени колебательности 

sim('chema');              % запуск Simulink-схемы моделирования привода и вычисле-

ния критерия точности 

if e > abs(E(end,:))+1000*(3-sign(h-0.01)+sign(m-50)+sign(U(end,:)-27))  %проверка 

выполнения ограничений и назначение штрафов 

В случае нарушения ограничений к минимизируем целевой функции abs(е) при-

бавляется большая константа (штраф). 

 

ЗАДАНИЕ НА РАБОТУ 

 

1. Изучить теоретические сведения. 

2. Подготовить Simulink-схему ЭСП к использованию инструмента Linear Analysis 

Tool. 

3. Получить набор типовых динамических диаграмм с помощью инструмента Linear 

Analysis.  

4. Выполнить анализ устойчивости и качества регулирования ЭСП с помощью диа-

грамм.  

5. Произвести с помощью моделирования в Simulink экспериментальную проверку 

правильности выводов, основанных на диаграммах. 

6. Оценить влияние изменения параметров регулятора (коэффициентов обратных 

связей по скорости и току, коэффициента усиления в прямой цепи) на запасы 

устойчивости и качество регулирования в переходном режиме. 

7. Оценить влияние начальных условий по скорости на функционирование ЭСП. 

8. Оформить отчет, в котором отразить теоретические сведения, результаты экспе-

риментальной работы (скриншоты ЛАФЧХ, диаграмм, осциллограмм сигналов) с 

комментариями, представить выводы по работе. 
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КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

1. Каковы типовые способы коррекции, которые применяют в следящих приводах? 

2. Как производится анализ устойчивости и качества регулирования линейной си-

стемы в пакете Simulink? 

3. Что представляет собой Simulink-схема ЭСП, подготовленная к использованию 

инструмента Linear Analysis Tool? Каковы начальные условия функционирова-

ния? 

4. Какие характерные режимы работы ЭСП соответствуют диаграммам во времен-

ной и частотной областях? 

5. Каковы показатели ТЗ на проектирование ЭСП могут быть оценены по динамиче-

ским диаграммам? 

6. В каких единицах измеряются величины на ЛАЧХ и ФЧХ? 

7. В каких единицах измеряются величины на графиках переходной и весовой 

функций? 

8. Осциллограммы каких сигналов получают при анализе динамики ЭСП? Какие по-

казатели оцениваются в виртуальном испытательном стенде? 
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ЛАБОРАТОРНАЯ РАБОТА №88 

 

ПАРАМЕТРИЧЕСКИЙ СИНТЕЗ РЕГУЛЯТОРА В СИСТЕМЕ МАТЛАБ 

 

1. ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

1.1 Оптимальный синтез коэффициентов регулятора стандартными средствами 

системы Матлаб 

Сформируем замкнутый контур управления. Введем в ЭСП с помощью датчика 

угла главную отрицательную обратную связь по углу поворота нагрузки. При этом бу-

дем полагать, что вход ЭСП – сигнал задания по углу нагрузки. Для расширения воз-

можностей обеспечения ТЗ введем в ЭСП с помощью соответствующих датчиков мест-

ные отрицательные обратные связи по скорости и току.  

Согласно ТЗ при оптимальном синтезе в режимах переброски и слежения в каче-

стве тестирующих входных сигналов будем использовать, соответственно, ступенчатый 

сигнал 1.57 рад. Simulink-схема замкнутого ЭСП третьего порядка с ограничителем 

представлена на рисунке. 

 

 
Рис. 1. Simulink-схема ЭСП 

 

Рассмотрим оптимальный синтез регулятора в линейной зоне. Его можно выпол-

нить по отдельности для двух рабочих режимов ЭСП с использованием стандартного 

блока оптимизации Signal Constraint.  

Рассмотрим оптимальный синтез в режиме переброски. В ТЗ требования к ЭСП 

по быстродействию и колебательности имеет вид: 

- время перемещения нагрузки на угол 1.57 рад (90 град) – не более 2 с; 

- перерегулирование – не более 10%. 

Подключение блока Signal Constraint к выходу нелинейной модели ЭСП (Мн ≠ 0) 

в режиме переброски показано на рисунке 2. В частном более простом случае, когда 

ЭСП работает в линейной зоне, подключение блока Signal Constraint к выходу линейной 

модели привода (при Мн ≠ 0) показано на рисунке 4. 

 
Рис. 2. Подключение блока Signal Constraint к выходу ЭСП в режиме переброски 
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Рис 3. Пример спецификации качества регулирования в параметрах блока Signal 

Constraint при единичном скачке на входе системы 

 

На рис. 4 отрезки задают следующие требования к реакции на единичное ступен-

чатое воздействие: 

- Амплитуда меньше или равна - 0.01 до времени нарастания 5 секунд, что соот-

ветствует недорегулированию (undershoot) в 1 % 

- Амплитуда изменяется в пределах между 0.9 и 1.2 до времени установления 

(settling time) в 15 секунд 

- Амплитуда не превышает 1.2 до времени установления в 15 секунд, что соответ-

ствует перерегулированию (overshoot) в 20 % 

- Амплитуда находится между 0.99 и 1.01 после времени установления, что соот-

ветствует установившейся ошибки (settling) в 2 %. 

Чтобы указать необходимые по ТЗ требования к качеству регулирования ЭСП, 

необходимо изменить время и амплитудные значения отрезков. 

 

 
 

Рис. 4. Подключение блока Signal Constraint к выходу линейной модели ЭСП (при Мн = 

0) 
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Рис 5. Спецификация качества регулирования ЭСП при ступенчатом сигнале 1.57 рад 

 

Для выбора и задания варьируемых (корректируемых) параметров регулятора 

надо нажать кнопку Non – появляется окно Create Design Variables Set (см. рис. 4, 6). 

 

 
 

Рис 6. Задание корректируемых параметров ki, kw 

 

 
 

Рис. 7. Результат оптимизации регулятора по двум коэффициентам обратных связей 

 

Результат неудачного выбора начальных приближений по параметрам регулятора 

ki, kw при оптимизации ЭСП представлен на рис. 7. Найденные параметры регулятора 

требуют изменения полярности обратной связи по току:  

ki =  - 0.0013 [рад/А]; kw = 0.0439 [с]. 
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После уточнения начальных приближений по параметрам регулятора (в m-файле 

параметров ЭСП) в результате оптимизации достигнуто требуемое по ТЗ время регули-

рования не более 2с и перерегулирование не более 10% при  

ki =  0.0107 [рад/А]; kw = 0.0934 [с]. 

 

 
 

Рис. 8. Приемлемый результат оптимизации регулятора 

 

ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

1. Построить модель ЭСП в пакете Simulink. 

2. Построить график переходного процесса. 

3. Замените числовые значения блоков параметров регулятора модели на переменные 

4. Объявите переменные в Workspace с начальными значениями. 

5. Добавьте в модель блок, Check Step Response Characteristics из библиотеки Simulink > 

Signal Design Optimization > Signal Constraints и подключите его к выходу системы. 

6. Используя исходные данные задайте допустимые границы коридора движения 

переменной. Постройте границы коридора введя команду Show Plot закладки Bounds.  

7. Нажмите клавишу Response Optimization закладки Bounds.  

8. Добавьте переменные регулятора в список Design Variable Set и задайте зону поиска 

переменных.  

9. Запустите процесс оптимизации параметров модели по реакции системы. 

 

ЗАДАНИЕ 

 

Скорректируйте ЭСП с помощью блока, задав требования из задания. Получите 

результаты моделирования синтезированной системы при ступенчатом сигнале на входе. 

 

КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

1. Какие преимущества можно получить при использовании Simulink Response 

Optimization в разработке систем автоматического управления?  

2. Как задается целевая функция в пакете Response Optimization? 

3. Почему следует рассматривать поведение модели с оптимизированными 

параметрами при разных входных воздействиях?  
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ЛАБОРАТОРНАЯ РАБОТА №9 

 

МОДЕЛИРОВАНИЕ ГАЗОВОЙ СИЛОВОЙ СИСТЕМЫ УПРАВЛЕНИЯ 

 

1. ЦЕЛЬ И ЗАДАЧИ РАБОТЫ  

Цель работы – экспериментальное исследование влияния на динамику и точность 

автоколебательной газовой силовой системы управления (ГССУ) амплитуды и частоты 

гармонического входного сигнала, а также флуктуаций параметров системы. 

Достижение поставленной цели связано с решением следующих задач: 

- построение схемы моделирования релейной ГССУ; 

- определение зависимости амплитуды и частоты автоколебаний от параметров 

входного сигнала и параметров системы; 

- построение схемы моделирования ГССУ с блоком вычисления амплитуды и фазо-

вого сдвига первой гармоники выходного сигнала; 

- построение экспериментальных частотных характеристик ГССУ по первой гар-

монике выходного сигнала; 

- оценка точности ГССУ по фазовому сдвигу, вносимому системой на частоте по-

лезного сигнала; 

- оценка степени сглаживания (фильтрации) вибрационной составляющей колеба-

ний руля в контуре телеуправления ракетой. 

2. ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

2.1. Вводные замечания 

Автоколебания, сопровождающие процесс управления, свойственны многим нели-

нейным системам, в частности, релейным, с логическим управлением и др. 

К статическим нелинейностям рулевого привода относятся: ограничение фазовых 

координат, гистерезис в электромагнитной подсистеме, сухое трение и люфт в механиче-

ской подсистеме и др. Нелинейности негативно сказываются на динамике и точности ру-

левых приводов и их влияние стремятся уменьшить. Для этой цели в приводе с релейным 

регулятором организуется вибрационный режим одного из следующих видов: 

- автоколебательный; 

- широтно-импульсной модуляции; 

- скользящий. 

Высокочастотные колебания обеспечивают вибрационное сглаживание и вибраци-

онную линеаризацию нелинейной системы по медленно изменяющемуся полезному сиг-

налу. Эквивалентная в режиме слежения линейная система используется для синтеза за-

кона управления. При этом используются хорошо развитые методы линейной теории, 

например, частотные методы. 

Практически важно, что в релейных приводах транзисторы импульсного усилителя 

мощности работают в ключевом режиме (“открыт-закрыт”). Это в сравнении с линейным 

законом управления обеспечивает высокий коэффициент полезного действия усилителя и 

упрощает систему охлаждения. Кроме того, в гидравлических и газовых приводах высо-

кочастотные колебания давления и расхода рабочего тела препятствуют засорению дрос-

селей смолами и продуктами горения пороха. 

2.2 Особенности функционирования рулевых приводов 

Характерной особенностью релейных приводов является то, что в них возникают 

незатухающие свободные периодические колебания, называемые автоколебаниями. Авто-

колебания являются установившимся процессом, который возникает в автономной систе-

ме, когда входной сигнал отсутствует либо представляет собой постоянную величину. 

Для многих релейных систем автоколебания являются рабочим режимом. Поэтому 

при проектировании таких систем большое внимание уделяется исследованию возникаю-

щих в них автоколебаний. Однако в газовом рулевом приводе с пропорциональным 
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управлением также могут возникать автоколебания, когда в нем имеются люфт, сухое 

трение, ограничения координат (например, в газораспределительном устройстве). 

Автоколебательный рулевой привод (РП) может быть с двухпозиционным или 

трехпозиционным релейным управлением. 

 

 
 

Рисунок 1 – Автоколебательный РП с двухпозиционным управлением 

 

Для автоколебательных рулевых приводов характерно следующее соотношение 

между амплитудой автоколебаний и максимальных отклонение руля (рис. 2) 

 
 

 
Рисунок 2 – Осциллограммы отработки полезного гармонического сигнала автоко-

лебательным рулевым приводом: 

- задающий сигнал (красная линия); 

- колебания руля (синяя линия). 

 

Из рис. 2 видно, что процесс на выходе рулевого привода содержит полезную мед-

ленную и автоколебательную быструю (вибрационную) составляющие. Система отраба-

тывает полезный входной сигнал с фазовым сдвигом, который зависит от частоты и ам-

плитуды входного сигнала. 

2.2 Постановка задачи моделирования динамических испытаний газового рулевого 

привода 

2.2.1 Построение принципиальной схемы рулевого привода 

Принципиальная схема ГССУ представлена на рис. 5. 

Газораспределительное устройство (ГРУ) 5 реализовано по типу «сопло-шарик-

заслонка». Электронный усилитель 6 имеет три составляющие части:  

- устройство, выделяющее сигнал рассогласования  в осU U ; 

- усилитель сигнала рассогласования по напряжению (может быть линейным либо 

релейным; линейный усилитель характеризуется коэффициентом передачи YK ); 

- усилитель мощности, который вместе с электромагнитом 7 образует единую ди-

намическую систему – электромеханический преобразователь (ЭМП). 

ЭМП управляет ГРУ. В представленной схеме использован нейтральный электро-

магнит. 

Рулевой тракт ГССУ имеет электрическую обратную связь. Для повышения надеж-

ности потенциометр датчика обратной связи сдвоен. 
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Рисунок 5 – Принципиальная схема системы: 1 - генератор газа; 2 - сбросовый кла-

пан; 3 - ресивер; 4 - двигатель; 5 - газораспределительное устройство; 6 - усилитель; 7 - 

электромагнит; 8 - фильтр очистки 

 

2.2.2 Построение математического описания функционирования рулевого привода 

Построим математическое описание (МО) функционирования газового РП в пере-

ходных и установившихся режимах функционирования. При допущении о равенстве тем-

пературы газа в ресивере и рабочих полостях получаем нелинейное МО функционирова-

ния релейного РП во всех возможных режимах функционирования 
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Здесь использованы обозначения: вU , mU  - входной сигнал и его максимальное 

значение; X , x  - координата поршня привода и заслонки ГРУ ( 0X   при нейтральном 

положении поршня; 0x   при нейтральном положении заслонки); mX , mx  - максималь-

ное значение координат; 1 2, ,pp p p  - давление газа в ресивере и рабочих полостях привода, 

соответственно; 1 2, ,pT T T  - температура газа в ресивере и рабочих полостях, соответствен-

но; нW  - объем рабочих полостей привода при 0X  ; nS  - эффективная площадь поршня; 

xa b , xa b  - законы изменения дросселирующих отверстий ГРУ; M  - приведенная мас-

са поршня; h  - коэффициент вязкого трения;   - коэффициент восстановления удара на 

упорах привода;   - коэффициент позиционной нагрузки (жесткость пружины); k , R  - 

показатель адиабаты и газовая постоянная; уK , осK  - коэффициенты усиления сигнала 

рассогласования U  и сигнала обратной связи осU , соответственно; э  - время эквива-

лентного запаздывания ЭМП;  0Tt t  - время функционирования; 1,2mp , 1,2mT , mV  - пара-

метры границы рабочей области фазового пространства системы. 

 

Отметим, что данное МО отражает как критические, так и докритические режимы 

течения газа через дроссели. МО отражает релейный режим работы ГРУ с учетом зоны 

неоднозначности (гистерезиса). В РП реализован принцип управления по отклонению, для 

чего  в систему введена отрицательная обратная связь по положению руля.  

Вид входного задающего воздействия (полезного сигнала) ( )вхU t  может быть: 

- ступенчатым (либо прямоугольный импульс) – в режиме переброски руля; 

- гармоническим – в режиме слежения. 

Силовая часть ГССУ может быть представлена линейной моделью в отклонениях 

от нейтрального положения, структурная схема которого показана на рис. 6. Эта модель 

имеет седьмой порядок. Без существенной потери точности привод можно описывать мо-

делью 3-го порядка (рис. 7). Упрощенное МО используют для исследования автоколеба-

тельного режима и режима отработки полезного сигнала. 
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Рисунок 6 – Структурная схема замкнутой ГССУ седьмого порядка с пропорцио-

нальным управлением 

 

 
 

Рисунок 7 – Структурная схема ГССУ с релейным управлением 

 

Здесь обобщенные параметры силовой системы РП определяются через конструк-

тивные и эксплуатационные параметры по зависимостям 
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2.2.3 Построение Simulink-схемы рулевого привода 

 
 

Рисунок 8 – Simulink-схема релейной ГССУ с корректирующим фильтром 

 

Параметры ГССУ следующие. 

1. Коэффициенты передачи: 

KV = 440 1/с    - добротность системы по скорости 

Kos = 0.25 В/рад   - коэффициент обратной связи; 

Kу = 3.26    - коэффициент предусилителя; 

2. Постоянные времени механической подсистемы газового двигателя: 

t1 = 11.6e-3 с, 

t2 = 0.00349 с; 

3. Постоянные времени термодинамической подсистемы газового двигателя: 

tc = 0.0455 с; 
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tr = 0.0273 с. 

4. Параметры нейтрального ЭМП:  

 

 
 

 
 

Параметры релейного звена Relay следующие. 

Величины полок реле (параметр с  = +/- 0.0255 задается в настройках звена Relay), 

ширина петли гистерезиса 2b  (параметр +/- b  задается в настройках звена Relay) – под-

бирается экспериментально для получения автоколебаний амплитудой до 0.035 рад и ча-

стотой до 100 Гц. 

 

5. Моделирование электромеханического преобразователя (ЭМП): 

 

 
 

 В настройке звена Transport Delay задается время эквивалентного запаздывания 

ЭМП равное τe = 1.98e-3 с. 

6. Параметры корректирующего устройства – интегрирующего фильтра при ча-

стоте входного сигнала 10 Гц и частоте автоколебаний 100 Гц следующие: 
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Simulink-схема релейной ГССУ с блоком вычисления ЛАФЧХ по первой гармони-

ке выходного сигнала представлена на рис. 9 

Для исследуемого рулевого привода соотношение между амплитудой автоколеба-

ний руля (4 град) и максимальным отклонением руля (15 град) от нейтрального положе-

ния имеет вид (в радианах): 
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ЛАБОРАТОРНАЯ РАБОТА №10 

 

АНАЛИЗ ПОДОБИЯ ЭЛЕКТРОПРИВОДА ПОСТОЯННОГО ТОКА 

 

ЦЕЛЬ РАБОТЫ: 

1. Изучение методики определения критериев подобия на основе анализа 

уравнений, описывающих функционирование системы. 

2. Построение нормализованного математического описания (МО) и формиро-

вание условий подобия функционирования автоматической системы. 

3. Освоение методов проектирования физической модели системы. 

1. ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

1.2 Анализ подобия системы 

Рассмотрим силовую подсистему электропривода постоянного тока, который пред-

назначен для перемещения звена манипуляционного робота. Получим методом анализа 

уравнений критерии подобия электродвигателя (ЭД). На основе этих критериев произво-

дится проектирование его физической модели (ФМ). 

Задача физического моделирования испытаний ЭД при изменении в к- раз инерци-

онной нагрузки является практически важной и формулируется следующим образом: 

необходимо спроектировать ФМ и с её помощью экспериментально исследовать динами-

ческие характеристики ЭД в лабораторном стенде. 

Отметим, что уменьшение нагрузки позволяет упростить и удешевить лаборатор-

но-стендовые испытания силовых приводов большой мощности, которая может достигать 

десятков киловатт. В то же время, изменение нагрузки в сторону увеличения позволяет 

упростить динамические испытания микромеханических систем. 

Проектирование ФМ ЭД производится на основе условий подобия функциониро-

вания систем. Получение критериев подобия основано на процедурах построения МО си-

стемы и его нормализации. Рассмотрим МО ЭД в переходных и установившихся режимах, 

которое представляет собой систему трёх обыкновенных дифференциальных уравнений 

вида 

; ;e m

di d d
L U i R C J C i h

dt dt dt

 
           

, 

где U - управляющее напряжение, max max[ , ]бU U U U   ; i  - ток в якорной обмотке; R,  

L  - активное сопротивление и индуктивность якоря, соответственно; 
, J

 - угол, угловая 

скорость и момент инерции якоря, соответственно; h - коэффициент вязкого трения; eC
 - 

коэффициент противо-ЭДС; MC
- коэффициент, определяющий зависимость развиваемого 

момента от тока. 

Введём безразмерные переменные и произведём замену исходных фазовых коор-

динат и времени по масштабным соотношениям: 

, , ,       б б б бi i i t t     
,  

где 
, , ,i   

 – безразмерные переменные; 
,, ,б б б бi t 

 – временно неизвестные 

постоянные множители (базисные величины). МО ЭД преобразуется к виду:  
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Преобразуем полученные уравнения к безразмерному виду делением на размерный 

множитель. Подчеркнем, что выбор базисных величин произволен. В целях упрощения 

МО целесообразно их выбрать так, чтобы максимальное число безразмерных комплексов 

параметров обратилось в единицу. Пусть, например, 

max;; ; ;      бб б б б б б

e

U U
U U L

i t t
R C R

   . 

Тогда получаем нормализованное МО ЭП в виде: 

2

;

;

;

[ 1, 1]

m e

di
U i

d

C C Ld h L
i

d J R J R

U

d

d















  


    

      
   




  



   

Следовательно, для того, чтобы обеспечить эквивалентность нормализованных МО 

сопоставляемых ЭД необходимо выполнение условий равенства определяющих критериев 

подобия в модели и оригинале: 

2
; .M eC C L hL

idem idem
JR JR

   

где " idem" – означает одинаковый, тождественный. 

Выполнение полученных условий подобия функционирования ЭП обеспечивает 

масштабное подобие переходных процессов ( ), ( ), ( )i t t t   в модели и оригинале. От-

метим, что безразмерные комплексы параметров  

1 22
,M eC C L hL

JRJR
  

 

называются определяющими критериями подобия; безразмерные переменные , ,i    

– определяемыми (зависимыми) критериями подобия. 

Таким образом, задача исследования динамики ЭД в зависимости от значений па-

раметров упрощается, т.к. анализ производится на плоскости двух обобщенных безраз-

мерных параметров 1 2,  , причем каждая точка плоскости соответствует шести исход-

ным размерным параметрам E M, , , , ,R L J c c h
.  

Эквивалентным условием подобия является условие 
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/ / // 1,j j j   
') 

где 
j

 - индикатор подобия; 

/ / /,j j 
. - значения критерия 

j
в оригинале и в моде-

ли, соответственно. 

Условия подобия систем в масштабной форме имеют вид 

1
П 1, 1, .ji

n
a

i
i

m j N


 
 

где  

/

/ /

i
i

i

m



  – масштаб воспроизведения в модели величины i .  Штрихи "/" и "//" со-

ответствуют значениям величины в оригинале и в модели. 

Условия подобия ЭП в масштабной форме записи принимают вид 

2
1; 1CM CE L h L

J R J R

m m m m m

m m m m
 

. 

Масштабы, связывающие значения переменных в модели и оригинале, при выпол-

нении условий подобия определяются следующим образом. 

В оригинале  

/ i i i ;   в ФМ  

/ / / / ,i i i  

поэтому 
/ / / ,ii m i

/ / /
/ / /

/ / /
/ ;R
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u

mR U
m i i

R U m
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/ / / /

/ / / / /

/ / / /
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.
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e сe
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t
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t mL R
m

t L R m





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На основе полученных выражений для критериев подобия, а также масштабов вос-

произведения в модели переменных оригинала формируется ТЗ на проектирование ФМ 

ЭД. 

Проектирование физической модели 

Рассмотрим в общем виде требования к ФМ динамической системы. 

Процессу создания ФМ предшествует этап формирования и формализации сово-

купности предъявляемых к ней требований, которая включает: 

 1) требования подобия модели оригиналу; 

 2) требования, отражающие специфику реализации модели; 

 3) требования тождественности некоторых величин модели и оригинала. 

Требования подобия – непосредственно следуют из определения понятия модели. 

При нарушении этих требований нарушается взаимно однозначное соответствие между 

процессами в модели и оригинале, что не позволяет достоверно судить о процессах в ори-

гинале, анализируя процессы функционирования модели. 

Математически требования подобия сводятся к требованию равенства численных 

значений критериев подобия в модели и оригинале. 

2
,M eC C L hL

idem idem
JR JR

  , 

или в масштабной форме записи 

2
1; 1CM CE L h L

J R J R

m m m m m

m m m m
 

    (1). 
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Требования специфики реализации ФМ – определяют необходимые отличия мо-

дели от оригинала, в силу которых эксперименты с ней более дешевы и удобны. 

Примерами требований специфики служат: требования уменьшения размеров мо-

дели, её мощности по сравнению с оригиналом; требование замены рабочего тела, исполь-

зуемого в оригинале (гелий, водород, аммиак, углекислый газ, пороховой газ и др.), более 

дешёвым, безопасным и/или менее агрессивным модельным газом, как правило, воздухом. 

Математически требование специфики сводится к выполнению условий 

im const
   (2) 

где  im
– масштаб, определяющий требуемое изменение некоторой величины i  в модели 

по сравнению с её значением в оригинале. 

Для ЭД требованием специфики реализации является уменьшение инерционной 

нагрузки J в k  раз, т.е. Jm k
, что позволяет упростить макетирование привода в ла-

бораторных условиях. 

Требования тождественности некоторых величин ФМ и оригинала – обуслов-

лены следующим. Часто значения ряда параметров оригинала неизвестны, Например, не-

известны точные значения коэффициентов демпфирования, расхода, восстановления на 

упоре (при соударениях) и т.п.. В силу этого оказывается невозможным осуществить про-

верку выполнения условий подобия. 

Использование в оригинале и ФМ одинаковых материалов, рабочих сред, кон-

структивного исполнения узлов позволяет реализовать тождественность этих параметров. 

В результате исключается неопределенность в условиях подобия. В условиях подобия эти 

параметры взаимно сокращаются, а в масштабной форме записи условий подобия мас-

штаб, соответствующий неопределённому параметру, принимает конкретное значение, 

равное единице. 

Кроме того, требования тождественности переменных часто определяются необхо-

димостью стыковки ФМ с реальной аппаратурой моделируемой системы (при создании 

полунатурных стендов). Отсюда следует необходимость сохранения в модели натурных 

мгновенных значений переменных, связывающих ее с реальными блоками. 

Математически требования тождественности состоят в выполнении условий 

1im 
,      (3) 

где  im – масштаб, определяющий требование тождественности некоторой величины i  в 

модели и оригинале. 

Для ЭП требованием тождественности является условие обеспечения при модели-

ровании реального масштаба времени 1tm  , что, например, связано с необходимостью 

стыковки ФМ с реальной аппаратурой в полунатурном стенде. 

Рассмотрим синтез параметров ФМ ЭП. 

После того, как требования, предъявляемые к ФМ, сформированы, приступают к 

проектированию модели. На первом этапе разрабатывают конструкцию модели. При этом 

решается задача обеспечения эквивалентности МО оригинала и ФМ на символьном 

уровне. Для этого необходимо сохранение в модели геометрической формы, конструктив-

ных признаков оригинала и физической сущности протекающих, в нём процессов. Напри-

мер, конструкция модельного манипулятора должна быть геометрической копией кон-

струкции оригинала. 

Часто конструктивная реализация ФМ осуществляется путём доработки некоторого 

прототипа модели. В качестве прототипа выбирают конструктивно эквивалентное или до-

статочно близкое к оригиналу изделие. При этом учитывают требования специфики реа-

лизации ФМ, а также стоимость и доступность прототипа. Так, для ЭД в качестве прото-
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типа ФМ, может быть использован натурный электродвигатель с уменьшенной в заданное 

число раз инерционной нагрузкой. 

На втором этапе реализации ФМ осуществляют расчет её параметров и масштабов 

воспроизведения переменных. 

Систему соотношений для определения параметров ФМ и масштабов моделирова-

ния образуют: 

- условия подобия (1); 

- условия специфики реализации (2); 

- условия тождественности (3); 

К условиям, которые накладывают ограничения на масштабы воспроизведения в 

ФМ переменных, добавляют зависимости, связывающие масштабы воспроизведения этих 

переменных с масштабами воспроизведения параметров. Система требований к ФМ ЭД 

имеет вид  
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    (4) 

После логарифмирования расчетной системы соотношений получим систему ли-

нейных уравнений 

A b 
,   (5) 

где 
   1 2 n 1 2 n, ,... ... lg , lg ...lg ...lg

T T

i im m m m       
 вектор неизвестных; компо-

ненты матрицы А и вектора b - числа. Система (5) имеет решение, если 

( , )rang A rang A b
   (6) 

Условие (6) – условие реализации ФМ. Его нарушение свидетельствует о противо-

речивости требований, предъявляемых к ФМ, и невозможности их совместного выполне-

ния. 

Если rang A n , решение системы (5) существует и единственно. В этом случае 

искомые масштабы определяют путём решения системы (5) с последующим потенцирова-

нием компонент вектора 


. 

Если rang A n , решение системы (5) существует, но не единственно. Для вы-

деления единственного решения значения некоторых параметров и масштабов задаются, 

например, из условия простоты реализации этих значений в ФМ. 

В зависимости от того, какие параметры задаются разработчиком, а какие рассчи-

тываются, получают различные варианты реализации ФМ. Таким образом, решение зада-

чи синтеза ФМ сводится к поиску множества всех приемлемых вариантов модели, для ко-

торых выполняется условие (6), и выбору некоторого предпочтительного варианта. 

После упрощений система (4) включает соотношения 
1 1, 1, , 1.CM CE R L R h J tm m m k m m m m k m     

 
Множество параметров ФМ ЭП, допускающих коррекцию имеет вид 

 , , , ,CM CE R L hm m m m m
. 
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Совокупность всех подмножеств данного множества определяет общее количество 

вариантов модели, требующих перебора и анализа 
52 32N   . 

Решение не единственно, если допустить свободный выбор 

, , , ,CM CE R L hm m m m m
. Однако, учитывая, что прототипом ФМ является натурный 

двигатель, целесообразно положить 
1CM CEm m 

, поскольку реализация такого вари-

анта не требует доработок двигателя. В этом случае множество параметров ФМ, допуска-

ющих коррекцию принимает вид 

 , ,R L hm m m
. 

Количество вариантов модели, требующих перебора 
32 8N   . Причём мно-

жество всех возможных вариантов модели включает следующие элементы 

 
     

     

 

, ,

, , ,

R L h

R L R h L h

R L h

m m m

m m m m m m

m m m


 

При этом для варианта с коррекцией одного параметра, например,  Rm  пред-

полагается, что 1, 1L hm m  ; для варианта без коррекции     – 

1, 1, 1R L hm m m  
 и т.д. 

Приемлемым вариантом ФМ ЭД, для которого существует решение системы (4) и 

оно единственное, является вариант В1 с коррекцией параметров 
 , ,R L hm m m

. Зна-

чения масштабов по корректируемым параметрам следующие 
1, , .R L R hm k m m m k  

 
При этом масштабы по фазовым переменным и времени следующие: 

; ; 1,uR
i w t

u CE

mm
m m m

m m
    

Варианты ФМ различаются в зависимости от выбора масштаба um
. Примем 

um
= 1, что упрощает сопряжение привода с управляющей аппаратурой, тогда 

1, 1i wm k m 
. 

Таким образом, в условиях, например, двукратного уменьшения в ФМ параметра J 

вариант В1 предусматривает увеличение в 2 раза в ФМ параметров R, L и уменьшение в 2 

раза параметра h. При этом масштабы по времени, по углу, по скорости – единичные. 

Масштаб по току получается неединичным (уменьшение в ФМ относительно оригинала 

уровня тока в 2 раза), что позволяет сберегать при испытаниях ресурс изоляции обмоток 

ротора. 

Полученные значения масштабов позволяют по значениям переменных в модели 

предсказать значения переменных в оригинале. 
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ЛАБОРАТОРНАЯ РАБОТА №11 

 

ПРОЕКТИРОВАНИЕ И ИСПЫТАНИЯ ФИЗИЧЕСКИХ МОДЕЛЕЙ 

ЭЛЕКТРОПРИВОДА ПОСТОЯННОГО ТОКА 
 

1.1 Вариант ФМ-1 

В качестве прототипа ФМ будем использовать натурный электродвигатель с умень-

шенной в 10 раз инерционной нагрузкой. 

Simulink-схема ЭСП, которая соответствует двигателю (с учетом вязкого трения), и 

вариант ФМ -1 с коррекцией параметров (R, L, h) представлены на рис.1. При этом 

 Масштабы по времени и по входному напряжению единичные. 

 Момент инерции нагрузки уменьшен в 10 раз; 

 Параметры (R, L) увеличены в 10 раз, коэффициент вязкого трения (h) – 

уменьшен в 10 раз, т.е. так же как изменен момент инерции;  

 Масштабы по углу и скорости единичные; 

 Масштаб по току: уровень тока в ФМ уменьшен в 10 раз; 

 Коэффициент ОС по току в ФМ увеличен в 10 раз. 

 

 
 

Рис.1. Simulink-схема сравнения оригинала и ФМ (вариант ФМ-1) 

 

Совпадение (конгруэнтность) экспериментальных осциллограмм углов, скоростей 

и токов в оригинале и ФМ (рис.2 - 4) подтверждает правильность расчета корректируемых 

параметров ФМ и масштабов моделирования переменных. 
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Примечание. 

Сравнение токов оригинала и ФМ на осциллоскопе 7 производилось с учетом ис-

кусственного увеличения тока ФМ в 10 раз. 

 

 
Рис.2. Осциллограмма угла 

 

 
Рис.3. Осциллограмма скорости 

 

 
Рис.4. Осциллограммы токов в оригинале и ФМ (с учетом искусственного увеличения 

тока ФМ, регистрируемого осциллоскопом 7, в 10 раз) 

 

Выполним вычисление среднеквадратической ошибки физического моделирования 

по углу, скорости и току при синусоидальном. 

 
Рис.5 Схема вычисления среднеквадратичного критерия аппроксимации по углу 

 

СК ошибки аппроксимации пренебрежимо мал и обусловлен ошибкой интегриро-

вания: -1.069e-17 [рад2]. 
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Рис.7 Схема вычисления среднеквадратичного критерия аппроксимации по скоро-

сти. 

 

СК ошибки аппроксимации пренебрежимо мал и обусловлен ошибкой интегриро-

вания: -2.199e-12 [рад/с]2. 

 
 

Рис.8 Ошибка идентификации (скорость). 

 
Рис.9 Схема вычисления среднеквадратичного критерия аппроксимации по току. 

СК ошибки аппроксимации пренебрежимо мал и обусловлен ошибкой интегриро-

вания: -2.826e-17 [А]2. 

 
 

Рис.9 Ошибка идентификации (ток). 

 

Из приведенных вычислений видно, что значения угла, скорости и тока оригинала 

и ФМ ЭСП совпадают. 
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1.2 Проектирование варианта ФМ-2 с ускоренным масштабом моделирования по 

времени 

Вариант ФМ-2 с коррекцией параметров (R, Ce, Uя) представлен на рис.5: 

 Масштаб по входному напряжению единичный. 

 Момент инерции нагрузки уменьшен в 10 раз; 

 Параметры (R, Ce, Uя) увеличены в 10 раз; 

 Масштаб по времени – ускоренный в 10 раз,  

 Масштаб по углу – уменьшенный в 10 раз; 

 Масштабы по скорости и току единичные; 

 Коэффициенты ОС по углу увеличен в 10 раз. 

 

 
 

Рис.10. Simulink-схема сравнения оригинала и ФМ (вариант ФМ-2)  

 

Примечание. 

Осциллограммы переменных оригинала и ФМ, представленные на осциллоскопах 

1, 3, 6 сравнивались с искусственным увеличением тока, скорости, и угла ФМ в 10 раз. 

Сравнение осциллограмм экспериментально подтверждает правильность расчета 

корректируемых параметров ФМ и масштабов моделирования переменных. 

 

 
Рис.11. Осциллограмма углов 
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Рис.12. Осциллограмма скоростей 

 

 
Рис.13. Осциллограмма токов 

 

Выполним вычисление среднеквадратической ошибки между оригиналом и ФМ по 

углу, скорости и току при синусоидальном входном сигнале. 

 
 

Рис.14 Схема вычисления среднеквадратичного критерия аппроксимации по углу. 

 

СК ошибки аппроксимации пренебрежимо мал и обусловлен ошибкой интегриро-

вания: 4.272e-7 [рад]2. 

 
Рис.16 Схема вычисления среднеквадратичного критерия аппроксимации по скоро-

сти. 

 

Из приведенных вычислений видно, что значения угла, скорости и тока оригинала 

и ФМ ЭСП с большой точностью схожи, СК ошибка по модулю не превышает 4.208e-4.  

1.3 Вариант коррекции (R, Ce, Uя) исполнительного двигателя в условиях с уско-

ренного масштаба моделирования по времени 
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Для моделирования реакции на единичный входной сигнал в модели ФМ с коррек-

цией (R, Ce, Uя) параметр См так же изменяется - уменьшается в 10 раз (рис.9). 

 
Рис.20. Simulink-схема сравнения двигателя (оригинала) и его ФМ 

 

Примечание. 

Осциллограммы переменных оригинала и ФМ, представленные на осциллоскопах 

сравнивались с искусственным увеличением в ФМ скорости интегрирования в 10 раз (за 

счет увеличения коэффициентов передачи интеграторов в ФМ в 10 раз). 

Сравнение осциллограмм углов, скоростей и токов (рис.21-23) экспериментально 

подтверждает правильность расчета корректируемых параметров и масштабов по пере-

менным. 

 
Рис.21. Осциллограмма угла 

 
Рис.22. Осциллограмма скорости 
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Рис.23. Осциллограмма тока 

 

Выполним вычисление среднеквадратической ошибки между оригиналом и ФМ по 

углу, скорости и току при ступенчатом входном сигнале. 

 
Рис.24 Схема вычисления среднеквадратичного критерия аппроксимации по углу. 

 

СК ошибки: 0.4563 [рад]2. 

 

 
 

Рис.25 Ошибка идентификации (угол). 

 

 
Рис.26 Схема вычисления среднеквадратичного критерия аппроксимации по току. 

 

СК ошибки: 6.228е-7 [А]2. 
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Рис.27 Ошибка идентификации (ток). 

 

ВЫВОДЫ 

 

В процессе исследования ЭСП постоянного тока и его ФМ: 

 Составлены Simulink-схемы оригинала и ФМ; 

 Получены критерии подобия оригинала и ФМ методом анализа уравнений; 

 Сформулирована задача проектирования ФМ ЭСП в условиях масштабиро-

вания инерционной и силовой нагрузки. 

 Спроектирована ФМ с уменьшенным в 10 раз моментом инерции нагрузки; 

 Выявлены два приемлемых варианта коррекции параметров ФМ-1 и ФМ-2; 

 Выполнено сравнение осциллограмм работы ФМ и оригинала, которое под-

твердило правильность проектирования ФМ. 
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ЛАБОРАТОРНАЯ РАБОТА №12 

 

ПРОЕКТИРОВАНИЕ ФИЗИЧЕСКОЙ МОДЕЛИ ДЛЯ ЛАБОРАТОРНО-

СТЕНДОВЫХ ИСПЫТАНИЙ МОМЕНТНОГО ЭЛЕКТРОПРИВОДА 

 

1. ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

1.1 Постановка задачи 

Рассмотрим задачу проектирования физической модели (ФМ) для испытаний сило-

вого моментного ЭСП большой мощности, который реализован на двигателе серии ДБМ. 

Предполагается, что ФМ в стенде работает на уменьшенную в n раз относительно ориги-

нала инерционную нагрузку. Потребность в физическом моделировании возникает, 

например, на этапе синтеза и экспериментальной отработки закона управления силовым 

приводом наведения и стабилизации, когда макетный образец еще не создан. Такой под-

ход делает доступным, удешевляет и упрощает экспериментальную отработку и динами-

ческие испытания ЭСП. 

Моментные двигатели с постоянными магнитами поставляются зарубежными ком-

паниями Danaher Motion/Kollmorgen, Axsys, Moog, Parker, ETEL, Siemens и др 

ОАО «Машиноаппарат» и ООО «МЭЛМА» (г. Москва) впервые в отечественной 

электротехнической промышленности разработали серию бесконтактных моментных 

электродвигателей ДБМ, охватывающую широкий диапазон вращающих моментов – от 

0,01 до 16 Н·м. 

 
Рис. 1. Общий вид электродвигателей серии ДБМ 

 

Функциональная схема электрического привода на базе бесконтактного исполни-

тельного двигателя представлена на рис. 2.  
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Рис. 2. Функциональная схема электрического привода на базе бесконтактного дви-

гателя: СПП – силовой полупроводниковый преобразователь; ДТ – датчик тока; ИД – ис-

полнительный двигатель; ДПР – датчик положения ротора 

 

1.2 Проектирование физической модели 

Рассмотрим два варианта проектирования ФМ ЭСП, связанные с выбором прото-

типа модели: 

1) прототип – это оригинальный двигатель ДБМ-100-0.4-1.5-2; 

2) прототип – это двигатель той же серии, но меньшей мощности, например, ДБМ-

50-0.04-6-2. 

Параметры ДБМ представлены на интернет-сайте производителей. 

Учитывая то, что мощные ДБМ имеют значительную стоимость (десятки тыс.р.), 

последний вариант является предпочтительным. Подчеркнем, что ДБМ малой мощности 

имеют стоимость в разы меньшую, чем мощные высокомоментные ДБМ. Выберем в каче-

стве прототипа ФМ второй вариант. 

Задача проектирования ФМ рассматривается как задача создания новой техниче-

ской системы, удовлетворяющей системе требований: 

1) подобия функционирования в виде равенства критериев подобия в оригинале и 

модели, либо в виде равенства индикаторов подобия единице 
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где m  – масштаб воспроизведения в ФМ некоторой величины   оригинала, причем 

м

ор

m




 . Здесь индексами “ор” обозначается оригинал, “м” – модель. 

2) тождественности функционирования оригинала и модели в данном случае – 

по уровням входного воздействия и сигнала ошибки; 

3) тождественности параметров оригинала и модели (в данном случае не зада-

ются); 
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4) специфики реализации ФМ, которая обусловлена необходимым отличием пара-

метров модели от параметров оригинала. В частности, прототип модели ДБМ-50 имеет в 

два раза меньшее по сравнению с оригиналом число пар полюсов Z, т.е. 0.5Zm  . 

Параметры ФМ, которые допускают коррекцию в стенде, следующие: напряжение 

питания U, коэффициент противо-эдс eс , коэффициент передачи фильтра Фk , коэффици-

ент обратной связи ОСk , постоянные времени фильтра 1 2,T T , момент инерции нагрузки J. 

Таким образом, множество корректируемых параметров ФМ имеет вид 

 1 2, , , ,, , ОСe ФU C k k T T J . 

В результате синтеза ФМ выбран приемлемый вариант и рассчитаны масштабы по 

корректируемым параметрам: 

1 1 Ô î ñ

1

=1.5; 0.4179; 0.3042;

; ; .

U ce J

T T t K U K

m m m

m m m m m m m



 

   
 

При этом масштабы воспроизведения в ФМ переменных (времени, ошибки, тока, 

скорости, угла) следующие: 

2;5837.3;4431.6

;7222.0;1;5571.0





 mmm

mmm iet
 

Рассмотренный вариант ФМ обеспечивает строгое подобие функционирования, т.к. 

выполняются равенства единице всех индикаторов подобия. В ФМ имеет место масшта-

бирование уровней тока, скорости, угла, причем в ускоренном масштабе времени (ускоре-

ние в 1.8 раза). При этом обеспечивается тождественность по уровням входного сигнала и 

сигнала ошибки. 

Отметим, что ускоренный масштаб по времени обусловлен меньшим в модели по 

сравнению с оригиналом числом пар полюсов. Практически важно, что ускоренный мас-

штаб протекания процессов при лабораторно-стендовых испытаниях сокращает время 

статистических испытаний и экономит ресурсы привода и стенда. 

1.3 Сравнительный анализ оригинала и его ФМ 

Компьютерное моделирование функционирования ЭСП и его ФМ подтвердило до-

стоверность полученных теоретических результатов (рис. 3). 

 
Рис. 3. Разгон ЭСП и его ФМ до предельных на классе входных сигналов V 

скорости и ускорения: а) оригинал; б) физическая модель 

В случае необходимости проводить испытания в реальном масштабе времени сле-

дует в качестве прототипа ФМ использовать двигатель с тем же количеством пар полю-

сов, что и оригинал, либо использовать непосредственно двигатель-оригинал. 
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Пусть за прототип ФМ взят оригинальный двигатель, который работает на умень-

шенную в n раз инерционную нагрузку. В этом случае рассчитанный вариант коррекции 

ФМ предусматривает n-кратное уменьшением в модели таких параметров как: коэффици-

ента противоэдс, напряжения питания, коэффициента передачи фильтра и момента 

нагрузки. 

Данный вариант обеспечивает строгое подобие оригинала и ФМ, а также тожде-

ственность функционирования модели оригиналу по времени, скорости, углу, входному 

сигналу и ошибке. При этом в ФМ имеет место n-кратное уменьшение уровней тока, вра-

щающего и нагружающего моментов. 

 
Рис. 4. Осциллограммы точностных испытаний в режиме разгона ЭСП по ошибке: 

а) оригинал; б) физическая модель 

 

1.4 Изучение конструкции механической подсистемы автоматизированного нагру-

зочного стенда 

Стенд состоит из двух моментных двигателей ДБМ70-0,16-3-2 и ДБМ 120-1,6-0,5-3, 

расположенных соосно и связанных механически. Каждый из двигателей имеет возмож-

ность функционировать в двух режимах: 

- в режиме исполнительного двигателя; 

- в режиме нагрузочного двигателя. 

Переключение между режимами предполагается осуществлять программно. 

Стенд позволит задавать кинематические параметры нагрузки путем изменения 

момента инерции нагрузки – осуществляется с помощью изменения массогабаритных ха-

рактеристик навешиваемой изменяемой нагрузки; нежесткость механической передачи 

предполагается изменять с помощью различной толщины пластины, соединяющий валы 

двигателей. 

Параметры стенда: 

- исследуемый/нагружающий двигатель №1: ДБМ70-0,16-3-2 

- нагружающий/исследуемый двигатель №2: ДБМ 120-1,6-0,5-3 

- датчик положения ротора: ЛИР-ДА190А-3-Н-21-05-RS-3-2 

- тип управляющего микроконтроллера: 1986ВЕ92У 

3D модель стенда в пакете Solid Works представлена на рис. 5. 
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Рис. 5.  3D-модель механической подсистемы автоматизированного нагрузочного 

стенда 

Отличительной особенностью стенда является выбор в качестве базовых мехатрон-

ных модулей – силовых систем с двухфазным и трехфазным исполнительными двигате-

лями. Это позволяет считать его универсальным инструментом, позволяющим отрабаты-

вать алгоритмы управления и их микропроцессорную реализацию для различных кон-

структивных особенностей исполнительных двигателей. 
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